Follow the steps in this chapter to
set up your PowerBook

and to learn about turning your
computer on and off.

Setting Up Your PowerBook

To set up your computer for the first time, you need the power adapter and
the power cord that came with your PowerBook.

Step 1 Plug the power adapter into a grounded outlet

Plugging in the power adapter recharges the computers batteries. You should
plug in the power adapter in case the battery has drained during shipping or
storage.

WARNING Use only the power adapter that came with your PowerBook.
Adapters for other electronic devices (including other portable
computers) may look similar, but they may damage your computer.

The only way to disconnect power from your computer is by unplugging the
power adapter. Make sure the power adapter can be easily disconnected.

= Plug one end of the power cord into the power adapter and the other end into a three-
hole grounded outlet or power strip.


Instructions

To continue reading, use the scrollbar on the right. To go to a new section, click its title on the left.
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WARNING This equpment s intendeda be dedrically grounded. Yur
PowerBook is equpped with a hree-wre gounding pug—a pug that
has a hird (grounding) pin. This dug will fit only a gounded A
outet. This is a sfety feature|If you are unale to inset the dug into
the outet, contac a licensed kedrician to repace he outet with a
propery grounded ouét. Do not déeat he puipose 6the giounding
plug!

Step 2 Plug the power adapter cable into the computer.

m Plug the power adapter cable into the power adapter port (marked with the icon =) on
the back panel of the computer.
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Step 3 Open the display
= Press the latch and lift up the display.

3 Press the latch to release the lid.

Power On key

Floppy disk drive

Postion the disday at a omfortalde viewing angle. You @an adust the angle
of the dsday at ay time by tilting it towards or aay from you.

Setting Up Your PowerBook
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Step 4 Turn on the computer
= Pressthe Power Onkey (marked with the icon @) at the upper right of the keyboard
to turn the computer on.

Power On key
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You shold hear a dne when you tum on he cmputer It takes the computer
a noment b stat up

When you see amething like this on yur screen,he mmputer $ reag to
use:

File Gi@ peas LansE nai -
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Note: Your screen shad look very smilar © this gcture but it mght not
look eadly the ame
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What to do next

Problems turning on your co mputer?

= The computer made a sound, but you can't see anything on the screen.

Use he brightness control (marked with the icon %) and contrast cntrol
(®) untl an image apars ad the screend eay to read.

Nothing happened when you pressed the ~ Power On key (marked with the icon @) .

Make sure he paver adapters firmly conneded b both the momputer ad
a paver urce If the paver adapters dugged into a paver strip malke
sure he paver strip 5 dugged in and tumed on Then try prasing © again.

You see a blinking question mark icon  on the screen.

This icon means hat you reed b install ystem sftware on he wmputeis
had disk. System sftwareindudes the piograns the computer ges ©
statt itsdf up. You recéved a set bsystem sftware dgks in the box with
your @mputer For instrudtions on nstalling s/stem sftware see
Appendix A

New Macintosh users:  If you hae never ised a Midntosh omputer lefore
go o Chapter 2 now to leam haw to use your PowerBook Then @ to
Chapter 4dr important healh and sfety instructions For help turning
your RowerBook df, or puttng your FowerBook © deep come bad to this
chapter oncequ hae leaned b use your FowerBook

New PowerBook users:  If you hae wsed oher Madntosh @mputers but are
new to the PowerBook, read he rest d this chapter br instructions on
turning the PowerBook df and puttng the PowerBook b deep Then @ to
Chapter 2d lean about sing the tra&pad and b Chapter 5d leam about
using the Gontrol Strip. Make aure you read Chapter 4f important healh
and sfety instrudions

Experienced PowerBook users:  Go b Chapter 2d lean about sing the
tradkpad, hen &im this book or informaion about gur nrew PowerBook
Important healh and sfety instructions are Chapter 4

Setting Up Your PowerBook
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Turning the PowerBook off

When the PowerBook is df, the cmomputer $ not &Wng any power or dong
any work. The tems shut down and off both refer © this state

= If the ompter is a, choose &ut Down from the $edal menu
Special

Clean Up Windowe
Eanply fragh.o.

Eject Disk H®E
Eraae fisk...

Restart

| Shutoown |

Sleep

» If the omputer is in deep, wake itby pressing any key on the keyboad
(except Gaps Lock), and then droose Sut Down.

» If a poblem with the @mputer prevents you from ¢ioosing St Down,
you @n tum off the omputer ly hdding dovn the Gontrol, Option,
3 (Command), and Power On @) keys at the same ime. This tums df
the paver and you will lose ay unsved work. Use his key combinaion
only if you annot cioose 8ut Down or Restatt from the $edal menu

Putting the PowerBook to sleep

When the PowerBook is in deep it has a darkned screen sialrost ptally
inadive, but apears ¢ be df. To put he cmputer ¢ deep:

= Chooselie Seep ommand from the Sedal menu (The mmputer mst
be on n oder for you © put it b deep)

Special
Clean Up Window
Engply Tragh .o

Lipnt sk H
Erase Disk...

Restart
Shut Down

Note: A green lght flashes at he bp d the disday when your omputer §
in deep

Chapter 1



Automatic sleep

If you dort use he mmputer dr several mnutes, it goes © deep
aubmaically (unless you thange the deep préerencs). This onsewes
battery paver.

To wake the mmputer press any key on he keyboad (except Gps Lock).
The screen will reapgar & it wes before he awmputer vent b deep

For more informaion on $eep and aubmaic deep see Chapter.6

Restarting a computer that's already on

You reed b restat your omputer—tun it off and badk on gjain
immediatdy—when you want to male cetain changes © setings, use a
newly installed gstem sftware fle, or stat up he mmputer sing a diferent
disk.

You abo need o restat if you see asystem eror” message on te screen
(indicatng a temporarydtware poblem). In this ase use he tra&pad b
dick the Restatt bution tat apars
To restait your aomputer:
= Choose Restart from the Special menu.

Special

Clean Up Window
Penpliy Tragho

Eisot Hisk HE
Erase Disk...

Shut Down

Sleep

When you choose Rstatt, the omputer pompts yu b sve your work,
closes all open piograns, and restats itsdf.

Choosng Restatt does not dfed your RAM disk (if you created oa) or its
contents

Setting Up Your PowerBook



Microphone

(D Contrast control

-0 Brightness control

Power On key

Floppy disk drive

Trackpad
Trackpad button

Sleep indicator

Modem port
(optional)

Security slot

Elevation feet

IO Video port
= Power adapter port
<-> Ethernet port

p N
< Apple Desktop Bus (ADB) port EL /% Modem/Printer port

¥ Sound input port <)) Sound output port



Go through the exercises in this
chapter to learn how to use
your computer and

the computer’s trackpad.

Learning to Use Your Computer

Your mmputer omes with a tubrial that teabes you the kesics The tubrial
is dvided nto two pats:

= Partl You stat the Macintosh Basics tour on your mmputey which presents
the besic «ill s you need b master

= Part2 After you mmpgdete he Macintosh Basics tour, you retun to this
chapter o pradice what you leaned. You ako lean sosme additonal kill s

If youve rever ulsed a Midntosh @omputer lefore you shold compete boh
parts d the tubrial.

If you are a experienced Madntosh wser youll want to lean haw to use he
tradkpad n the first pat of the Macintosh Basics tour. Then you ma want to
look over te rest d this book b lean about spdal featurs d this omputer
As you work with your Madntosh, onsilt the Macintosh Reference book for
ansvers b questons abouthe ystem sftware hat @ame with your omputer

IMPORTANT If you reed 6 tum df your omputer at ay paint before
finishing the tubrial, please see “lirning the PowerBook Of” in Chapter 1
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Part 1 Starting the Macintosh Basics tour

Chapter 2

Your Macintosh Basicstour is on he had disk thats indde your omputer To
take the ur, follow these steps:

Make sure your omputer $ tumed on If the screens dark try adgusting the
screen (see “Bblems Turning On Your Gomputer?” h Chapter 1) uiityou
see words and small jictures on yur screen

Move your finger on the trackpad to move the arrow pointer around on the screen

Place yur index finger on he tra&pad and your humb on he tra&pad
button. Dorit press the trakpad butbn yet.

Move your finger acoss the trakpad, vatching the arow on the screen
Notice hat he arow moves in the ame diredion & you move your finger on
the tra&pad.

Trackpad  Trackpad button



You wse he tra&kpad b move the pdnter on he screenri the same diredion
you nove your finger over the pad. he tra&kpad b sengive © not ony the
diredion you nove your finger, but ako to how fast you nmove your finger.

If you want the panter b move a shar distance acoss the screen, u nove
your finger dowly acioss the trakpad. The faster you nove your finger
acioss the pad, e farther the pdanter noves on he screen

Tips for using the trackpad

ooooooooooooooooooooooooooooooooo

For best results when w&ing the tra&pad:
= Use your index finger (l€ft or right hand). Use ony one finger.

= Use ony your finger on he tra&pad. Db not tse a gn or ay
other ohject.

= If you tink that he tra&kpad reeds ¢ be nore or les
respongve o your bud, you @n adust the speed h the
Trakpad ontrol panel. See ‘Adjusting the Tradkpad in Chapter
7 for help using the Tradkpad ©ntrol pandl.

= Extend your PowerBooKs devation feet vhen it is daced on a
desktop This gives your fingers letter acess © the keyboad and
makes it eaier to use he fip of your finger on he arface é the
tradkpad.

= Adjust the height d your chair so you are seatedoenfortally
and at a ge dstance flom the dek. For more informaion, see
“Arranging Your Work Area and Equpment in Chapter 4

= Sometimes humdity or cmndenation mg cause noisture o
gather on he trakpad. If his hapgns genty wipe the tra&kpad
with a ¢ean doth before you se it.

Learning to Use Your Computer
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2

The Control Strip

Chapter 2

Notice the Control Strip at the bottom of your screen

File GiE Peas LERE il -

RO D =T P P PO ET Al

The Gontrol Strip is the line d pictures at he lower Idt of your screenYoull
leam more abouthie Gontrol Strip in Chapter 5

Move your finger on the trackpad so that the tip of the arrow is on the tab at the far end
of the Control Strip.

B ER T =D Y P R R ’[“"5@

Being careful not to move your finger on the trackpad, press the button once.

The Qontrol Strip doses and ony the tab appars athe lower l€ft of the
screen
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Move your finger on the trackpad so that the tip of the arrow is on the picture labeled
“Macintosh HD.”

Make sure he fip of the arow is over te pcture not oser the words
“Madntosh HD’

Move the arrow so that it
is on top of this picture.

Being careful not to move your finger on the trackpad, press the button twice in quick
succession. (This is called “  double-clicking .")

Now your screen shad look like the illustraton following step 7The itens
in the illustraton below may not xadly matd those on gur screenThe
only item you reed rght nawv is the Madntosh Basics folder

If the screen desrit look right, try steps 5mad 6 aain, paing spedal
attenton b the following:

= Make aire te ip of the arow is buching the gcture not he words
bereah it.

= Be sire b press the trakpad butdbn wice

s Press wice quckly and be ardul not to move your finger on he trakpad
while you pres

Learning to Use Your Computer
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7

so that itis on
top of this picture.

8

Chapter 2

Move your finger on the trackpad to place the tip of the arrow on the picture of the folder
labeled “Macintosh Basics.”

Tis (08 ias Laas igan % 1]

Being careful not to move your finger on the trackpad, press the button twice in quick
succession.

Now your screen shadd look like the following illustraton:

File [ie P Laas

e s

o L0l - BT e - ma——

L




9

10

11

Move your finger on the trackpad so that the arrow is on the picture of the man labeled
“Macintosh Basics.”

E[[=—— Macintosh® Basics HIE
14 itemns 2.9 MB in disk 34.2 MEB available
¥ .
%} Move the arrow so that it
ey is on top of this picture.
] [

Press the trackpad button twice in quick succession.

Now your screen shad look like the following picture:

Macintosh

Basics

Welcome to Macintosh Basics! I'll be your host throughaout this
tour of the Macintosh. As youwork through Macintosh Basics,
yowlllearn whatyou need to get started using your Macintosh,

Press the Return key to continue

1990 Apple Computar, Inc.

If you dort see lis screen, trygain, paiing spedal atteniton b the
following:

= Make aure he tip of the arow is buding the dcture not he words
bereat it.

» Be aure D press the trakpad butdbn wice

» Press wice quckly and be ardul not o move your finger on he tra&pad
while you pres

Follow the instructions on the screen and work through the tour.

When you finish te ur, continue with the rest d this dhapter

Learning to Use Your Computer
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Part 2 Practicing your new skills

Chapter 2

You shold nov hare mmpeted he Macintosh Basics tour.

The seond pat of your traning gives you an oppotunity to think about
what youve leaned ® far and © pradice your rew ill s

Reviewing what you've learned

Before mntinuing, take a Bw moments 6 answver these qustions They will
help you simmarize e informaion you leaned in Macintosh Basics. You
may want to write (or ércle) your answvers & appopriate The @rred
answvers are the next sedion d this dhapter

If you hae any troubde answering the quetions look in Chapter 3‘Basic
ills”

Question: What is he rame d the aea where you do dl your work? (t's s1own
below)

Answer:




Question: What are pgctures an the Macintosh desktop called? o exampes ae
shown below

Answer:

File El@ P Leas

L What is the name for these
pictures on the Macintosh
desktop?

Circle the hard disk  window in the illustration below.

Learning to Use Your Computer
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Chapter 2

Circle the hard disk icon in the illustration below.

File [ie P Laaw

Question: Cirde the active window on the desktop below How do you meke a
window active?

Answer:

Fir id8 B Lok ipen 1]




Question: Which menu is the Sve ommand in?

Answer:

Question: How do you throw an tem avay?

Answer:

Label the parts of this window.

A

| B.

[
E[l=— Macintosh il =——"P
23 itemns 423 MEB in dizk 24.5 ME available

Systemn Folder My Work Read Me Sirnple Text

5]

Learning to Use Your Computer
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Answers to the review questions

Chapter 2

These arehie answvers b the simmary hat you mmgeted edier.
Question: What is the aea called where you do dl your work?
Answer: the desktop

Question: What are fictures @lled on the Macintosh desktop?

Answer: icons

Circle the hard disk  window in the illustration below.




Question: Circle he ative window shown on the desktop below How do you
make a wndow active?

Answer: by dicking arywhere insde d it

Question: Which menu is he Sve ommand in?
Answer: the Rle nenu
Question: How do you throw an tem avay?

Answer: by dragging it to the Tash and choosng Empy Tash from he $ecial
menu

Label the parts of this window.

|A. Thedose hox I_B. Thetitle bar
Efl=—— Macintosh il =———VF:
33 iterns 423 MB in disk 34.5 MEB available

| C. A scroll arrow

8 [

Systemn Folder My Work Read Me Sirnple Text

D. The scroll bar

&l [olg}—E. Thesize box

Learning to Use Your Computer
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Practice session

Now you @n pradice what you leaned in Macintosh Basics Youll be
pradicing your ill s ising real pograns that ame with your omputey
rather than the sampge ones in Macintosh Basics.

IMPORTANT If you et lost at ay paint during the pradice sesion, or if
something urexpeded happens please tun to “Clues on Yur Sreeriin this
chapter These tps will help you ¢et badk on trad.

1. Creating a new document

1  Open the hard disk icon and then open the SimpleText program  , as shown below.

1 Double-click the hard disk
icon to open it.

2 If a window with the name
of your hard disk doesn't
appear, click the disk icon

| ]
)
]

L T T again twice.

3 To open the SimpleText
program, double-click the
SimpleText icon.

|
Ll

Untitled &=ie="iF"——"——"5|

When the SimpleText program
opens, a window appears with

“Untitled” in the title bar. This is
your blank document.

Chapter 2



Use the keyboard to type a few lines of text into the blank document

El

Untitled "Fi—"—o"_5

erase it.

This is a practice file. | am typing just to find out what it feels
like. If | make a mistake, | can use the Delete key to back up and

o>

Type text in the blank document.

It doesrit matter vhat you type If you male an eror, press the Ddete ley to
badkspace wer the incorred letters then rety

Choose the Save command from the File menu to save your new document

When you sve a daument you are giring it on he had disk. You need ©
save e/ery daument you createlf you doft save it, the document & lost
when you tum df the mwmputer

| Fire

MEiE N
FEEr T r I i
Close EW
Save As...
Page Setup...
Print... xP
Quit #0

Choose Save from
the File menu.

A box like te ore in the rext step appars with the word “Untitled’ near he
bottom. This bo lets you nane and sve your dacument.

Learning to Use Your Computer ¢
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4

Type the name of
your document to
replace “Untitled.” _|

Don't click anywhere. Just type the name “Practice File.” Then click the button labeled
Save.

— Macintosh HD * I

O fead Mp
0O System Folder
G BimpieTont

— Macintosh HD

fipot
Desktop

Save this document as:

| rr—— =] =)

The nane you type shold repace he word “Untitled’ i n the bo. If it
doesrit, place he padnter b the It of the U in “Untitled; then pras the
tradkpad butbn and dray acoss the word. When “Unitled’ is highlighted
(the text is surrounded wih a Badk ba), type the new nane

— Macintosh HD VI — Macintosh HD
0 Bepd vip §jpot
O System Folder -
< Shnpiefent Desktop

-_] |__Click Save to save your

save this document as: Practice File on the hard disk.

|Practice File

After you dick Save, a opy of your daunment i sbred on lhe had disk in
your @mputer The new name apgears i the title bar of the dacument.

The name of your document
appears in the title bar.

El Practice File 0|

Chapter 2

This is a practice file. | am typing just to find out what it feels |4
Tike. If | make a mistake, | can use the Delete key to back up and
erase it.



5  Choose Quit from the File menu to quit the SimpleText program.

Mg i

e, ik

Close ®W

e HiE

Save As...

Page Setup...

Print... ®P ] ]
Choose Quit from the File

menu to quit your program.

The SmpleText program ¢oses, along with your dacument
6  Check for the file you saved in the hard disk window.

You shold see lte icon for the daument you sved in the had disk window.
If your Pratice Rle icon dcesrit appeatr it may be in a hdden patr of the
window. You @an scoll through the window to find the icon if you reed 6.

E[I== Macintosh HD =M
I0items 420 MEindisk  Z4.7ME a
— ki

Systern Folder

L If you don’t see your document,
click the arrows to scroll through
the window.

Simple Text

Here's the new file _—
you just created. Practios File

Thats the end dthe first exerdse You mgy want to take a break &ore you
continue

Learning to Use Your Computer ‘ 25
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Chapter 2

2. Storing your work inside a folder

You @n omanize your work on he Madntosh ly creaing foldersand sbring
your dacuments ndde d them

Choose New Folder from the File menu

A folder icon naned “untitled folder” appears h the adive window on he
dektop

E[I== Macintosh HD HE
Elitems 420 MEindisk  Z4.6MEa

A new folder icon appears
Systern Folder

in the hard disk window.

untitled folder

EEE
Read Me SirnpleText

b,

Practice File

Without clicking anywhere, type “My Work” to name the folder

Notice hat he words “untitled folder” are hijhlighted ad boed. That means
the nane you type will redace hese words

ECI=— Macintosh HD =

31 items 422 ME in dizk 346 ME &

]

Systern Folder My “work

The new name of your
folder appears here.

E&E
Read Me SimpleText

Practice File




n

Drag the Practice File into the folder named “My Work

Move the panter b the Pratice Rle. Then pres and hdd dowvn the butbn
while you nove the Pratice Rle to the folder naned “My Work” When he
tip of the panter s on he folder icon and the folder kecomes highlighted,
release hie buton.

EC1== Macintosh HD =
3 items 422 MBindisk  346MEa

EEE
Read Me SirnpleText

Move the pointer to this icon. Then press
and hold down the button while you move
this icon to the folder named “My Work.”

n

Open the folder named “My Work

You ofen a blder he same way you open awy icon: doulbe-dick it, or dick it
once ad choose @en from te Fle menu

The “My Work” folder window opens and you @n see gur Pratice Hle.

mMacintosh HD
Z0iterns 422 MBindisk  Z4EMBE a
[
=E[1=—= My Work =—H1%
= 1 jtem 422 MBindisk 4.6 MBEa
e -
Read Practice File
I
] [

You hae nhaw comdeted he seond pratice exerdse You mgy want to tale a
break lefore ontinuing.

Learning to Use Your Computer ‘ 27
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Chapter 2

3. Throwing an item away

As you work, you will want to renove itens you no bnger reed fom the
had disk. You renove itens by throwing them into the Trash In this exerdse
you will throw the Pratice Rle into the Trash

If the Macintosh HD window is not already open, open it by double-clicking the
Macintosh HD icon.

If the folder named “My Work” is not already open, open it.

Note: If you @t see he Trash icon (which shodd be in the lowerright
corner d your screen) mmve the windovs o that he Trash icon is visble. To
move a window, place he panter in the window's itle bar (the stripes at he
top d the window), and dra the window.

Drag the Practice File to the Trash icon

File [l P Lo i

Place the pointer on the Practice
File icon. Press and hold down
the button as you move the
pointer to the Trash icon.

When the tip of the pointer is on
the Trash icon and the Trash
icon becomes highlighted,
release the button.

When you dace & item in the Trash, it s not imnediatdy renoved from
your disk. The Trash icon bugesto shav you that tie Pratice Rle is in the
Trash, but stl on your dik.
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Your Practice File is
in the Trash.

Open the Trash icon (by double-clicking it) to see your Practice File there.

File Ede B Lawe i

Open the Special menu and choose Empty Trash.

A dialog box appears The omputer dsdays a dalog bax when it aks you ©
confirm an adion. You must dick OK or another butbn in the dialog box
before you @an take any other adion.

Click OK.
The Trash s empied and the Trash icon retuns b nomal.

The Empty Trash @mmand permanenty renmoves from your disk anything
that i in the Trash Always be sure hat you knav what youre renoving
before you dhoose Enpty Trash

Note: You @n get an item kadk from the Trash ty moving its icon bad to
your disk before you choose Enpty Trashfrom the Sedal menu After you
choose Enpty Trash, you @rit re@ver itens youve thrown avay.

You hare mmpeted all é the pratice eerdses Before you mntinue wih
your ovn work, you might want to kim Chapter 3“Basic Xills” for a
summary é basic «ill s that youll need a you work.

Learning to Use Your Computer
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What's next?

The best way to get experience wrking with your omputer $ © begin to do
your ovn work. You mg have alreagl purchased appcation piograns o
work with. Youll need b install hese on pur had disk. Be sire b read he

manuals that ame with your appication piograns for informaion on hev to
install hem

Clues on your screen

Chapter 2

As you work, ched the screen frequelgtfor these impotant dues about
where yu are If you are bst or if ®mething unexpeded hapgns ak
yoursdf these qustions:

Is this the right program?

Chedk the menu lar. If it looks like this examge, you are n the Finder If
any of these menu namas are diferent or nmesing, you are h another
program To get bad to the Finder dick anywhere on lhe dektop patten.

IThe Finder menu bar




Is the correct window active?

Usually only the adive window is dfeded when you type or se a nenu The
adive window has stripes in its itle bar. To male a whdow adive, dick
anywhere ndde it.

Is the icon or text you want to work with selected?

Commands yu choose h ments wually work only if an icon or ®me text is
sdeded. Cled the item yu want to work with to male sure its highlighted
(which means its sdéected)

Is it best to start over?
If you get stu& or lost & you pragice on he cmputer try ore or nore d
the following renedies and then stat the pradice sesion over gain:

= |f an urwanted or onfusing windaw is on yur screen,lick the Close ba
in the upperleft corner d the windaw to dose it.

s If an urwanted wndow or box contains aCancd button, dick it.
= If the Ale menu ontains te word Quit, choose it.
» If youre realy stuk, restat your omputer

To restat, dick the dektop (the badkground pattem on your screen)and
then dcoose Rstat from the $edal menu This tums he computer &f
and then kadk on When you restart a @mputer problems dten dear up

Learning to Use Your Computer
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Refer to this chapter for information

on basic Macintosh skills.

Basic Skills

This setion piovides informaion on he following basic ill s:

Working with icons

Working with windows

Working with documents

Working with disks

Organizing your dektop

Working with menus

Keyboad shotcuts in the Fnder and in diredory dialog boxes
Using spedal keys on he PowerBook keyboad

33
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Working with icons

represent folders,
programs, and
documents that
are stored on the

An icon is a pcture hat repreents smething dse

This icon represents

the hard disk.

Selecting icons

To do this

Select the icon
Deselect an icon
Select multiple icons

Deselect aniconina
group of selected icons

Select multiple icons
that are near each other

Select a list or partial
list of icons

This icon represents
the Trash.

Follow these steps

Click the item.

Click anywhere except the selected icon.

While holding down the Shift key, click each icon.
While holding down the Shift key, click the icon.

Lo

Place the pointer at one corner of a group of icons.
Press and hold down the button.

3. Drag diagonally to select the icons, then release the
button.

no

=

Place the pointer to the left of the top icon or the bottom icon.
2. Drag up or down the list, releasing the button when the items
are selected.



Copying icons
To do this

Copy a file onto
another disk

Copy anicon on
the same disk

Opening icons
To do this

Open an icon
(disk, folder, etc.)

Moving icons
To do this

Move an icon on a disk

Naming icons
To do this

Select text in an
icon’s name

Rename an icon

Follow these steps

Drag the icon of the file to the icon of the other disk
or to an icon or window that belongs to that disk.

1. Click the icon to select it.

2. Choose Duplicate from the File menu, or press $-D.

3. If you wish, rename the new icon and drag it to a new location.
You can also make a copy by holding down the Option key while
you drag the icon to another folder or window.

Follow these steps
1. Click the icon.

2. Choose the Open command from the File menu. Or double-click
(click twice quickly) on the icon.

Follow these steps

Drag the item to the location you want.

Follow these steps

Click the icon name (not the icon itself).

1. Select the text under the icon.
2. Type the new name.
3. Press the Return key.

Basic Skills
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Removing items from the disk and retrieving them from the Trash

To do this Follow these steps

Drag the icon to the Trash.
Choose Empty Trash from the Special menu.

Erase or remove
an item from a disk

Open the Trash icon.

Drag the icon out of the Trash (and into the disk or folder window
where you want to store it). Or, choose Put Away from the File menu
to return the icon to its original place on a disk.

Retrieve an item
from the Trash

I ol A o

Working with windows

A window openswhen you doulbe-dick an icon. A window usually shaws
you whats ingde an icon.

Click the close box Click the zoom box
to close a window. to resize a window. |
SI==———— Macintosh it =———oPE ,
ZZ items 42 3 ME in dizk 345 1B avanabie | Click the scroll arrow to view

| contents that you cannot see.

| Move the scroll box up or down
to view the contents of a window
that you can't see. The gray in

———

System Folder My Work Read Me Simple Text

he scroll bar indicates that there
& = . :
| e are contents of the window that
This is a window showing you Drag the size box to you cannot see.
what's on the the hard disk enlarge or reduce the
named “Macintosh HD.” window.

E Chapter 3



Viewing the contents of a window

To do this Follow these steps

View the contents 1. Pull down the View menu.

of a window by name, 2. Choose the menu item that corresponds to the way you want to
date, size, or kind view the contents of the window.

View the contents of the 1. Choose any list view from the View menu (any view except the
window in outline form icon and small icon views).

2. Click the triangle next to a folder name to display or hide the contents

of the folder.

Making a window active

To do this Follow these steps

Make a window active Click anywhere inside the window or double-click its icon.

Opening higher level folders or disks

1 Hold down the 38 key as you press
the title of the active window.

2 Drag to choose a higher-level folder
(or disk) and then release the button.

=] Control Panels|-

Harne =) System Folder
O Color = M™acintosh HD  |ne
[ Date & Time Tk control panel
[ Easy Access 12K control panel
[1 File Sharing Monitar Sk control panel
[ General Contrals 23K control panel
O Keyboard 9K control panel
[0 Labels Ik control panel

Basic Skills
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Working with documents

Chapter 3

Opening and closing a document

To do this Follow these steps

Open a document 1. Click the icon for the document.
2. Choose the Open command from the File menu. Or double-click
(click twice rapidly) on the icon for the file.

Close a document Choose Close from the File menu. Or click the close box of the
document window.

Opening a document from within a program

To do this Follow these steps

Open a document 1. Choose Open from the File menu.

when you are working 2. Click the name of the document. (The

in an open program illustration shows how to find a folder that you might not see.)

3. Click the Open button.

Press this label to open a pop-up
menu of folders and disks.

] M!! Work v I

O Rachel Andrews memo . — Macintosh HD
0O sandy's memo
Desktop
[_Open ]
5

The documents in the disk or
folder you choose are listed here.



Saving and naming documents

To do this

Save and name a
document
for the first time

Save the document
under another name
(Save as)

Follow these steps

W R e

Choose the Save command from the File menu.
Type a name for the document.
Click the Save button.

Choose the Save As command from the File menu.
Type a new name for the document.
Click the Save button.

Choosing a folder when saving a document

To do this

Save a document while
working in a program

Follow these steps

Choose Save or Save As from the File menu.

Click the name of the folder you want to save your document in.
(The illustration shows how to find a folder that you might not see.)
Click Open to open the folder.

Name your document.

Click the Save button to save the document inside the folder.

Press this label to open a pop-up
menu of folders and disks.

— Macintosh HO

™ ganag]™— Macintosh HD I § et
&g Desktop | e
Desktop
| 15 J—
Save this ducur]wnt as: Cancel

Untitled

The documents in the disk or

folder you choose are listed here.

Basic Skills
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Working with disks

Chapter 3

Preparing a new floppy disk for use
See “Using Disks’ in the Macintosh Reference book

Ejecting a floppy disk

To do this

Eject a floppy disk

Follow these steps

Drag the disk's icon to the Trash.

Copying the contents of a disk

To do this

Copy the entire contents
of one floppy disk onto
another floppy disk

(with one disk drive)

Copy an entire floppy
disk onto a hard disk

Copy items from a hard
disk onto a floppy disk

Copy items from a floppy
disk onto a hard disk

Follow these steps

.

= ok w

ME e

Insert the original floppy disk into the floppy disk drive.

Drag the floppy disk icon to the hard disk icon. (The floppy disk
contents appear in a folder on the hard disk.)

Drag the floppy disk icon to the Trash.

Insert the floppy disk that you want to copy to.

Drag the icon of the newly created folder to the floppy disk icon.
Drag the floppy disk icon to the Trash.

Drag the icon for the floppy disk to the icon for the hard disk.
(The floppy disk contents appear in a folder on the hard disk.)

Select the items you want to copy.
Drag the selected icons to the floppy disk’s icon or window.

Select the items you want to copy.
Drag the selected icons to the hard disk’s icon or window.



Erasing the contents of a disk

To do this Follow these steps
Erase the entire 1. Insert the disk you want to erase into a disk drive.
contents of a floppy disk 2. Click the icon of the disk you want to erase.

3. Choose Erase Disk from the Special menu.

4. Respond to the messages on your screen by clicking the

appropriate buttons.

Organizing your desktop

Creating a new folder

To do this Follow these steps
Create a new 1. Choose New Folder from the File menu.
folder 2. Type a name for the folder.

3. Press the Return key.

Placing an icon inside a folder

To do this Follow these steps
Place an icon 1. Drag the icon to the folder where you want to store it.
inside a folder 2. Release the button when the folder icon becomes highlighted.

.
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Working with menus

Dimmed commands
are not available.

To choose an item from a menu:
1 Point to the menu.

2 Press and hold to pull down the menu.
3 Drag to the item you want to choose.

This is the Help menu,
which you use to display

4 Release the button when the command is information about items on

highlighted.

the screen.

This is the Application menu,
which you use to see which
programs are open.

Keyboard shortcuts in the Finder and in directory dialog boxes

Chapter 3

Key

Up, Down, Left,
or Right Arrow key

Tab key

Character key (a, b, c...)

3&-Down Arrow
38—Option-Down Arrow
38-Up Arrow
38—Option-Up Arrow

Return or Enter

Action

Selects the next item in the direction of the arrow

Selects the next item alphabetically (except in a directory dialog box and
the Chooser)

Selects the first item whose name begins with that character (or the
character following closest to it in the alphabet)

Opens the selected icon
Opens the selected icon and closes the current folder
Opens the folder that contains the current folder

Opens the folder that contains the current folder and closes the current
folder

In a dialog box: the same as clicking the button with the bold outline

In the Finder: selects the selected icon’s name for editing or saves the
edited name



Tab key

Special keys on the PowerBook 520, 520c, 540, and 540c keyboard

Escape key

Function keys Delete key  Power on key

-
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Caps lock key:

Control key
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Option key 38 (Command) key Enterkey Arrow keys Return key  Shift key

Arrow keys

Caps Lock key
% (Command) key

Control key
Delete key
Enter key

Escape key

Function keys

Option key

Power On key

Return key

Shift key
Tab key

Move the insertion point, as an alternative to using the pointing device.
In some programs, the arrow keys have other functions.

A locking Shift key for letters only (numbers and symbols aren't affected).

Works in combination with other keys as an alternative to choosing a menu
command.

In combination with other keys, provides shortcuts or modifies actions.
Deletes selected material, or the character to the left of the insertion point.

In a dialog box, pressing Enter is the same as clicking the outlined button.
In some programs, confirms information you have provided.

The function of this key depends on the program you're using.

Some programs allow you to use function keys to give commands. You
can assign commands or action sequences to function keys with utility
programs.

In combination with other keys, produces special characters or modifies
actions.

Turns on the computer.

Moves the insertion point to the beginning of the next line. In a dialog box,
pressing Return is the same as clicking the outlined button.

Produces capital letters (or the upper character on the key).

Moves the insertion point to the next stopping place (such as a tab stop or
data field).

Basic Skills  +
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Refer to this chapter for important
health-related information
and safety tips

Health, Safety, and Maintenance Tips

Important care and safety instructions

For your owvn safety and that d your equpment read ad follow all the
instructions i this setion. Keep hese nstructions &ailade for reference i
you and oters

Warning

Eledrical equpmentmay be haardous if misused. (peraton d this
product, or smilar pioducts, must alvays be supervised ly an acllt. Do not
allow children acess © the interior of any eectrical product and do not
permit them b handle any cades.

Do not se he mmputer h or rear vater

Do not se @desthat are frged or oherwise damged. Hdd a @le by its
connedor (the dug, not hie ord) when @nneding or dsmnneding it.

Always handle tatteries carefully.
Do not dop, pund¢ure muilate or bun the mmputer or httery

Recdhaige katteries only as described in this manual and ony in venilated
area.

Transpot batteries @ther ingde he computer or wih the piotedive dider
covering the kattery ontads

45
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Chapter 4

Do not shot-circuit the kattery teminalk (that 5, do not albw a netal
objed auch & a papr dip or key chain to touch the teminalk). Doing
may cawse an exploson or a fre

Caution

If you hare a poblem with your omputer ad nohing in the mmputer
manuals lves the pioblem, take the wmputer ¢ your Apple-autorized
dealer or sefice povider Attemping to repar the omputer pursdf may
void the limited warranty.

Do not nove the mmputer viien you @n hear its had disk sgnning.
When you put he omputer © deep wait unil the screens dank before
moving the computer

Never force a onnedor into a pot. Make sire hat he onnedor matdes
the pot and that its right sde up If the cnnedor and pot do not jon
ealy, they do not matb.

Do not tse he mmputer h wet or disty ervironments

Keep dit and liguids avay from the potts on he badk pand, the keyboad,
and the trakpad. If you spll any food or Iguid onb the omputer shut it
down immediatdy and urplug it before deaning up he spll. Depending
on what you splled and hav muc got into the cmputey you mg have ©
bring the mmputer & an Apple-auhorized serice povider br deaning.

Do not buch the screen wit any shap or panted oljeds

Use ony the kattery sipdied with your momputer Batteries designed for
other potalde computers myalook smilar, but ey may not work with
your mmputer ad mgy damae it.

When rebaging the battery use ony the paver adaptesupgied with
your @mputer Adapters degned Pr other dectronic devices mg not
work with your equpment and mgy damae the computer or lie redhager.

Do not leae batteriesin hot bcations (sich & the trunk of a ar).



Important

= Use he computer onf in ervironments wiere he temperature rageis
between ®°F/10°C and D4°F/40°C.

= Do not xpose he mmputer o very low (less than —B°F/-25C) or very
high (more han 140°F/60°C) temperature.

= If the @mputer ha been n a ©ld gdace br several hourslet it warm up b
room temgrature kefore you se it.

» Clean the mmputels outsde sirfaces with a damp (not et) doth. Clean
the screen wit oft, lint-free pagr or ¢oth and a mitl gass deaner. Do
not sprg the dass deaner diredly ono the screen

Caring for batteries
= Always handle latteries ardully.

= Do not shot-circuit the kbattery teminak (that 5, do not budh bot
temrminalk with a netal olject). Doing 0 may cause a exploson or a fre

= Do not dop, pundure disassemite, muilate or indnerate he battery

» Redage katteries ony as described in this maual and ony in venilated
area.

= Do not leae atteries in hot bcations (sich as the trunk of a ar).

= Do not leae a lattery n your omputer ér longer than a week wihout
plugging in the paver adapter

= Do not leae a lattery n sbrage for longer than 6 nonths without
rechaging it.

= Take dead btteries © an Apple-auhorized sevice povider r regcdling or
proper disposl. The hatteries mntain haardouws dhemicals and shold not
be thrown out with howsehad or dfice trash
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Health-related information about co mputer use

Chapter 4

Musde soreress, eye faigue and oher dscomforts and injuries smetimes
associated wih using computers an occur from performing any number d
adivities In fad, misuse d the same musdes during mutiple adivities @n
create a mblem that mght not oherwise &ist. For examge, if you ergage
in norwork adivities that involve repetitive stras on he wrist—such &
bicycling—and abo use Your momputeis keyboad improperly, you ma
increae yur likeihood d developing wrist poblems. Some individuals
are at greatergk of developing these poblems because d their healh,
physiology, lifestyle, and general exposire b stress Work omanization end
conditons such & workstaton setup ad lighting, also pay a pat in your
overall healh and comfort. Prevening healh problems is a mitifaceted tsk
that requres ardul attenton b the way you use Your bod every hour ¢
every dg.

The nost omnon healh dfeds asociated wih using a @mputer are
muscuoskeletal dscomfort and /e faigue Well di scuss eab area ®
concen below.

Musculoskeletal discomfort

As with any adivity that involves stting for long periods d time, using a
computer en malke your miwsdes ©re and stff. To minimize hese éfeds, set
up yourwork ervironmentcardully, usng the guiddines that ollow, and tale
frequent break b rest ired msdes. To male working with your computer
more @mfortalde, allow enowgh spacer your work area 8 that you @n
change pod&ion frequery and mantain a reéaxed posture

Another type d muscuoskeletal mncen is repetitive stras injuries (RSls),
also knowvn s cumdative trauma diorders (CTDs) These ppblems @n
occur when a cetain musde or tendong repeatedy overused ad forced nto
an unnatural pason. The exad cawses d RSIs are notdtally undersbod, but
in additon © avkward posturesuch fadors @ te anount d repettion, he
force sed n the adivity, the individuals pltysiology, workplace stres level,
and lifestyle mgy affed the likelihood d experienéng an RSl.



RSIs did not siddeny arise when @mputers wre nvented; tenrd dbow and
writers crampfor exampe, are wo RSIs that hae been wih us for a bng
time Although less omnon than other RSls, one serous RSl discussed nore
often bdey is a wrst poblem alled arpal tunrel syndrome, which may be
aggravated ly improper ise d computer leyboads This rerve disorder
results from excessive pressure on he median nerve & it passes through the
wrist © the hand.

This setion dfers adice on sethg up your work areao enhace yur
comfort while you wse yYour @mmputer Snce he dfeds d repetitive
movenments asociated wih using a @mputer an be ompounded Y those
of other work and lasure adivities © produce or ggravate plysical problems,
proper use d your @mputer gstem mgt be mnsdered & just ore dement
of a healty lifestyle.

No ore, of course can guarantee hat you worit hase poblems ezen when you
follow the nost expert advice on wing computer egipment. You shold
always died with a qalified healh spedalist if musde, joint, or g/e
problems occur.

Eye fatigue

Eye fatigue @n occur whenever the g/es are bcused on a early oljed for a
long time This poblem occurs lecauwse he e7e msdes must work hader b
view an olject thats doser han about 20det (6 neters) Improper lighting
can hasten he derdlopment d eye fatigue Althowgh g/e fatigue s aanoying,
therés no @idence lhat it leadsd pemrmanent damge.

Whenever youre emgaged in an adivity that involves dose-up work—auch &
readng a maazine, dang crdt work, or Lsing a @omputer—Ie sire b have
aufficient dare-free Ighting and give your g/es frequent rst break by
looking up and focusing on dstant oljects. Remember © have your ges
examined regulany.

To prevent dscomfort and g/e fatigue:

= Arrange your work space @ that tie fumiture s popefy adusted br you
and daesrit contribute b an avkward working posture

s Take frequent sharbreals © give your misdes and g/es a hance b rest.

Health, Safety, and Maintenance Tips
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Chapter 4

Arranging your work area and equipment

The siggestons n this setion @n help you work more @mfortaldy with
your omputer

Chair

An adustabe dchair that povides firm, comfortalde suppott is best. Adjust
the height d the dhair 0 your tighs are horizontalral your feet flat on
the floor.

The bad of the dair shoud suppott your lower badk (lumbar region).
Follow the manufadurers instructions br aqusting the bacrest © fit your
body propety.

Keyboard and trackpad

When you wse he keyboad and tra&pad, yur sholders shold be
relaxed. Your upger am and foream shoud form an appoximate rght
angle, with your wrist and hand in roughly a straght line

o o o o o o o o
[IT XTI T TIT [T T XTI T T
T I LT LT T LT 1]

This / Not this

You ma have b raise yur dair 0 your foreams and hands are atite
proper angle to the keyboad. If this males it imposible to rest your feet
flat on he floor, you @n use a botrest with agustalle height and it to
make up br any gap ketween he floor and your feet. Or yu mg lower
the dektop b diminate he need br a botrest. Anoher opton is b use a
desk with a leyboad tray thats lower than the regular work surface

Use a Ight budch when typng or wing the tra&pad and keep pur hads
and fingers réaxed. When wsing the tra&pad, &oid rolli ng your thumbs
under ypur palns.
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This Not this

Some computer sers my develop dsamfort in their hands wrists or ams
after intensve work without break If you begin to deselop cronic pan or
disammfort in your hands wrists or ams, consult a qualified healh
spedalist.

s Change hand podtions dten b avoid fatigue

» If you prder, you @an adust the angle of the keyboad by lowering the legs
until they snap nto postion.

-
i
V. :/

The bad of the keyboad is dighty elevated vhen e lggs are h use
Otherwise the keyboad is level.
Mouse

» If you wlsBe an external nouse postion the nouse at he same height &
your keyboad. Allow adeqate spaceotuse he mouse @mfortaldy.

Built-in display

= Adjust the angle of the disday to minimize dare and rdlections flom
overhead Ights and windows.

= You mg need b adust the brightness and cntrast of the screen wen you
take the computer fom ore work location © another, or if the lighting in
your work area hanges

Health, Safety, and Maintenance Tips
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External monitor
If you ise an extemnal nonitor, this siggestion ma be helpful.

» If possible, arange the nmonitor 0 the p d the screens dighty below
your g/e level when youre stting at he keyboad. The best distance flom
your g/es  the screend up b you, alhough nost ppogde seemd prder
18 to 28 nches (4 o 70 cm)

Avoiding fatigue

s Change your seated pdtson, stand up or stretb whenever you stat to fed
tired. Frequent shobreals are lelpful in redudng fatigue

= Allow adeqgate workspace g that you @n work comfortaldy. Flace paprs
or other itens O you @n view them eaily while using your mmputer A
document stad ma malke reading papers nore @mfortalde.

s Eye muwsdes must work hader b focus on rearly olgects. Oacasionally
focus your g/es on a ditant oljedt, and Hink often while you work.

= Clean your screen igulaty. Keepng the screenlean helps redice
unwanted rélections

What about electromagnetic emissions?

There ha been recent puir discisson d the posible healh dfeds o
prolonged eposire b extrenmely low frequeng (ELF) and very low
frequeng (VLF) decromagnetic fields Quch fields are ssociated wih
eledromanetic Lources sich as tdevison setsdectrical wiring, and sme
howsehdd appiances—as well as mmputer nonitors

Apple ha reviewed seentfic repots and ©ught the munsé of government
regulaiory agendes and respeded healh omganizatons Based onhe
prevailing evidence ad opnions Apple believes that he dectric and
magnetic fields poduced ly computer nonitors do not pose aelalh risk.

In responsed those cstomers who wish b redice heir exposire
eledromanetc fields Apple ha lowered he emssion levels d its produds



This chapter describes working with
the Control Strip, the line of modules
at the bottom of your screen.

The Control Strip

What is the Control Strip?

When you first tum on your RowerBook, a line d small pctures apgars n
the lower It of the screenThis is @lled he Control Strip. Eadh picture in the
Control Strip is alled amadule.

The Gontrol Strip is a quck and eay way to monitor and update gur
PowerBooKs paver management optons For instance you @an monitor the
battery dhaige level and the anount d work time It on your battery You @n
also adust such opions & Hle Sharing and ound volume

Scroll arrows let you view

Control Strip modules Power Sound Scroll
that are not visible. File Sharing Settings Volume Arrow|
Close Box [ 5[E »] @ NNNlnnl0A » 20 D] [ 2 [ [ [ ] D
AppleTalk Battery Monitor HD Spin Down Sleep Videol  Tab

Switch Now  Mirroring

The Gontrol Strip may look dightly different depnding on he optons on
your PowerBook

To et a dscripion d ead module in the Gontrol Strip, pul down the Help
meny choose Sow Balloons ad pant to the nodules ore at aitme



How does the Control Strip differ from control panels?

Many featurs in the Gontrol Strip work the same wey as @ntrol panels For
the most pat, however, control panels dfer more optons The Gontrol Strip
gives you an eay way to acess the featurs you wse nost dten You @n sill
use he @ntrol panels anytime © fine-ture your setitngs.

Closing, opening, and resizing the Control Strip

Closing the Control Strip

The Gontrol Strip appears onhe dektop untl you dose it. Ybu @n dose he
Control Strip one d two ways:

1 Click the tab at the end of the Control Strip.

2 Click the close box at the beginning of the Control Strip.

The ontrol Strip appears ondp d apdication piograns When you dose
the Gontrol Strip, only the tab appars athe edje d the screen

Opening the Control Strip
To open he Gontrol Strip:

= Click once on the tab.

The Gontrol Strip opens

54 ' Chapter 5



Resizing the Control Strip

You @n shoten or legthen he Gontrol Strip to disday fewer or nore

modules
= Click and drag the tab.

The Gontrol Strip shotens or legthens a you dray the tab If you shoten

the Gontrol Strip and @n no bnger see alllie nodules, use te scoll arrows.

Hiding the Control Strip

If you want to hide he Gontrol Strip so it does not apear at all ontie

desktop:

1  Choose Control Panels from the Apple (@) menu, and open the Control Strip

control panel.

¢l

——

Control Strip

2 Click Hide Control Strip.

S[1= Control 5trip

' () Show Control Strip
- (@) Hide Control Strip

The Gontrol Strip aubmatcally disappears fom the screen

Click Show Control Strip in the Gontrol Strip control panel when you want
the Gontrol Strip to reapgar

The Control Strip
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Moving the Control Strip

You @n drgy the Gontrol Strip to the right or Idt edge o your FowerBooKs
screen or @y monitor your RowerBook is mnneded b. To repo#tion the
Control Strip:

Hold down the Option key and drag the Control Strip by its tab.
An outine d the Qontrol Strip shawvs where he Gontrol Strip will move .
Release the Option key and trackpad button.

The Gontrol Strip appears n its nrew postion, and remans here unil you
move it again.

Rearranging the modules in the Control Strip

You @n cwstomize he oder d the modules in the Gontrol Strip. To rearange
the nodules:

Hold down the Option key and drag  each module you want to move.
Release the Option key and trackpad button.

The nodule you are naving snapsnto gace The modules sty in the new
order unil you rearange them

Using the Control Strip

Chapter 5

Monitoring the charge level of the battery

Your ommputer dravs paver from ore or o rehagealble batteries The
Battery Monibr module in the Gontrol Strip lets you eaily monitor the
battery haige level for eah battery n your PowerBook. The tal work time
you ¢et from the katteries deends on he often you wse he had disk, how
bright the screeng and oter fadors



The charge level and
battery icon for the
left battery are
displayed on the left.

The Battery Monibr has four pats:

= battery ton for eat battery

= battery daige level for eat battery
= total kattery onsumpion rate

= total esimated vork ime remaning

A battery icon appears for

leach battery you use. The estimated work time

remaining is displayed here
when the batteries are

[ |
B Illllllll[l[la » | | 321 #|  powering the computer.

|The charge level and The battery consumption rate is displayed

battery icon for the here when the batteries are powering the
right battery are computer. Higher rates are to the right.
displayed on the right.

The kattery hage level, battery @nsumpion rate and esimated vork time
remaning change degnding on he ftware hadware and paver sving
featurs you wse

The kattery tons tiange de@nding on whether the kattery & being chaiged
is fuly chaiged, or § pavering the @mmputer Notice hat he battery
consumpion rate ad the work time remaning are dsgdayed ony when te
computer $ being povered ly the kattery

When the battery is powering the
computer, this icon appears.

B DUNnolondild » ey | =210

When the power adapter is plugged in and
charging the battery, this icon appears.

When the power adapter is plugged in and

g? [“] 0 Ill 0 IIII .EJ:_I' | the battery is fully charged, this icon appears.

‘The charge level changes as the battery charges.

When the power adapter is plugged in and the
batteries are not in the computer, this icon appears.

|
|
AT

The Control Strip

57



Customizing the Battery Monitor module

You @n cwstomize he Battery Monibr module to disday only the features
you want. Follow these steps:

1  Click the Battery Monitor module in the Control Strip.

The following pop-up nenu apears

Hide Battery Lewvel
Hide Battery Consumption
Hide Tirne Fernaining

A Dinoonondlg #] R

2 Choose the feature you want to hide or show.

You @nnot hide e mattery cons

Changing the battery conservation settings

You @n ontrol your @mputels paver onampion wing the paver
conseraton setings in the Power Settings nodule. You @n ako open te
PowerBook mntrol panel from the Fower Stiings nodule.

1  Click the Power Settings module in the Control Strip.

A pop-up nenu apears

Open PowerBook Contral Fane]—f— Open the PowerBook control panel if you want to
use the Custom settings.
# Botter Conservation———— ] Better Conservation gives you longer work time.
Better Performance —— 1 Better Performance allows you to work with the
7 , fewest interruptions.
=

2 Choose the feature you want from the pop-up menu.

The kattery onsewation setings shavn are dentcal to those shan in the
Easy View area 6the RowerBook @ntrol panel. For help with the
PowerBook mntrol panel, see Adjusting the Battery Gnsewation Setiings’
in the “Maximizing Work Time’ sedion d Chapter 6
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Spinning down the hard disk

The had disk is ore d the man consumers @ battery paver. To extend work
time while you are ging your kattery it is a g@od idea 6 tum df the had
disk when you are not sing it. This is @lled “spnning dovn” the had disk.

To spn down the had disk:
Click the HD Spin Down module in the Control Strip.

A pop-up nenu apgars

Spin Down Internal Hard Dizk I

A0 h

Choose Spin Down Internal Hard Disk.

The icon shaevs that he had disk is df.

I:lh

The had disk aubmatcally turns itsdf bad on when he wmputer reds it.

Putting the computer to sleep

Putting your FowerBook © deep when you tale a work break even or a Bw
minutes, can give you nore work time from your kattery To put your
PowerBook b deep flom the Gontrol Strip:

Click the Sleep Now module in the Control  Strip.

A pop-up nenu apears:

Sleep Mow
g
I

Choose Sleep Now.

Note hat when your PowerBook is in deep a green fiht flashes at he bp o
the mmputels dispay.
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2

Your PowerBook goes 1 deep To wake the ammputer fom deep press ay

key on the keyboad. There aretiree oher ways you put your FowerBook

deep:

= close he mmputels dsday

= choose lhe Seep @mmand from the Sedal menu in the Fnder

= hdd down the  (Command) and Shift keys while you press and rdease
the zeo (0) ley.

For more informaion on $eep see Chapters Ind 6

Changing the file sharing options

The icon d the Hle Sharing module tells you whether file sharihg is on ad
whether wsers are @nneded.

|:| ¢ File sharing is turned off.

Q p+— File sharing is turned on and no users are connected.

@ p+— File sharing is turned on and at least one user is connected.

To change te file sharng opion or ogen te Fle Sharing Setup ontrol pand:
Click the File Sharing module in the Control  Strip.

A pop-up nenu apears:

Mo Users Domnecied
Open Sharing Setup

Turn File Sharing On

[ 1»

Choose the file sharing option you want from the pop-up menu.

For more informaion on fle sharig and working on a metwork, see he
Macintosh Reference book



Changing the sound settings
Your mputels und wlume @n be danged from the Gontrol Strip:
Click the Sound Volume module in the Control ~ Strip.

A pop-up nenu apears:

el L O ) e

]

i

Choose the volume setting you want from the pop-up menu.

For more informaion on sund, seehe Macintosh Reference book

Turning an AppleTalk connection on and off
The icon for the AppleTalk Svitch module shaws if AppleTalk is on or @f.

p1— AppleTalk is off.

p4— AppleTalk is on.

Turning AppleTalk off can save you kattery pever. You @n tum AppleTalk on
and df from the Qontrol Strip.

Click the AppleTalk Switch module in the Control ~ Strip.

A pop-up nenu apears:

& AppleTalk Active
AppleTalk Inactive

|
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Choose the feature you want from the pop-up menu.

For more informaion on AppleTalk and working on a etwork, see e
Macintosh Reference book

Using video mirroring

If your PowerBook is mnneded b an external nonitor you an dispgay the
same imae on he intemal dspgay and an external nonitor. This feature $
called “video mrroring”

When ax external nonitor is wnreded b your FowerBook, the Video
Mirroring module appears i the Gontrol Strip. The icon shavs whether
video mrroring is on or df.

j | — Video mirroring is turned off.

p +— Video mirroring is turned on.

You @n tum video miroring on and df from the Gontrol Strip.
Click the Video Mirroring module in the Control ~ Strip.

A pop-up nenu apgars:

Turn Yideo Mirroring On I

] b

Choose the feature you want from the pop-up menu.

The Video Mirroring module difers exadly the same featurs & the
PowerBook Disday control panel. For informaion on @&ng the RFowerBook
Disday control panel, see “Wing a Monibr for Presentaitons in Chapter 9



Read this chapter to learn how
you can maximize your
PowerBook’s battery life.

Power Management

Power sources

Your computer an draw its operatng powver from wo different surces

= Main batteries Your computer hdudes ore or tvo nickel-metal-tydride
(NiMH) batteries (degnding on tie nodd you hae). Two batteries
provide paver for up b 8 hours bwork time (degnding on te hattery
consewation feature you dhoose)

Your PowerBook ha spacedr two batteries. You @n keep om or o
batteries in the cmputer at aime If you need maimum work time, youll
want to keep bol batteries in the computer If you want your PowerBook
to weigh less, you @n keep o kattery n the omputer ad purhiase a
separate &ttery doora cover the hattery lay when he hattery s not n the
computer

= ACpower You @n run your @mputer fom any standad dedrical outet by
plugging in the paver adapter

The power adapters realy two pover sipdies in ore It can run your
computer ad chaige your katteries at the same ime

These pover ©urces are dscribed in more detail h the following setions
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Responding to low-power messa ges

Chapter 6

When e batteries run low, the computer dsdays a seris d low-power
messages. If you are ging two batteries in your RowerBook, the low-power
messages apear when boh batteries are dw.

The work time remaiing ater you seelte first message varies degnding on
how you are ging the momputer Its a @od dea b ad prompty.

What you should do
When you see adw-power message, you shold do awy of the following:

= Pluginthe power adapter , or
= Save your work and put the computer to sleep,  or

= Replace the empty batteries with charged ones.

What you should know

When te first low-power message apgears the screen dim aubmaically to
save paver.

If you oontinue b work without pugging in the paver adapter orlanging
the katteries, the mmputer dsdays a seond bw-power message

The seond nmessage is followed by a hird and final message indicating that
the computer § abouta put itséf to deep Within a Bw seonds the
computer ges b deep aubmaically to proted the mntents 6RAM. All
adivities are nterupted. I's a @od idea b save your work when you seelte
first wo low-power messages o male sure you dort lose nformaion.

If you ontinue working unil the ammputer ges b deep aubmaitcally, you
can wake it ggain as oon & you dug in the paver adapter or réace o or
both batteries with chaiged batteries. If you tale boh batteries out d the
computer male sire he paver adapters dugged in or you will lose ay
unsaved work.

If you arit plug in the power adapterthe contents 8RAM are retaned in
deep br about a da(as long as you dort renove te katteries).



IMPORTANT Redhalge depeted fatteries & 0n & posible. Leaiing depeted
batteries in the computer ér longer than 2 weels (espedally in a hot bcation,
such as the trunk of a ar) ma damae the hatteries so that hey carnt

be rechamged. If this hapens you reed 6 regdace he katteries

Recharging the batteries

To redaige the katteriesin your omputer plug in the paver adapter

The batteries are rebaigedregardless d whether you are sing the ammputey
or the aomputer $ df or in deep When te computer $ shut dan or in
deep boh batteries are baiged at he same ime

WARNING Use ony the paver adapteritat @ame with your cmputer
Adapters ér other dectronic devices (induding other potake
computers) myalook smilar, but hey may damae your omputer

A lightning bdt icon appears n the Battery Monibr module in the Gontrol
Strip when he power adapters dugged in and a lattery 5 rehamging.

& [00nm

Power Management ‘ 65



Redhaging two fully depeted latteries tales aboutwo hours wih the
computer shut dan or in deep or about dur hours if pu are ging the
computer

While the mmputer $ shut dan and the paver adapterd dugged in, you
may renove dhaged katteries from the computer ad repace hem with
batteries you want to chage

Ched to see if a httery B fuly chaged ty looking at he Battery Monibr
module in the Gontrol Strip.

Removing or replacing the batteries
To renove or repace he hatteries, follow these steps
1  Save your work, and then choose Shut Down or Sleep from the Special menu.

You @n ako pug in the paver adapter if gu want to keep he computer on
while you renove the latteries.

2 Close the display.

3 Open the door of the battery you want to remove by sliding the door in the direction
indicated by the arrow.

The door § plysically attadied b the kattery
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Carefully pull the battery you want to change out of its compartment

Make sure you nove the piotedive sider hat overs he lattery ontads ©
the kattery ontads are not @osed vinen he kattery 5 out d the mmputer

If you are inserting another battery, slide it into the battery compartment

You @nnot inset a kattery when te piotedive dider s vering the kattery
contads.

If you just inserted new batteries, it's a good idea to plug in the power adapter in case
the batteries are not fully charged .

IMPORTANT Nickel-metal-tydride (NMH) batteries contain metak which are
hazardows when rdeased n the ervironment It is inapppopriate and in ome
cases unbwful, to throw batteries avay with your howsehdd or bisiness trash
Instead bthrowing awvay your sgent katteries, dispose bthem & described
here

= Inthe United States Retum spent katteries © your Apple-authorized sevice
provider, who will male sire tey are nduded n Apples kattery regcling
program

= Elsewhere Many locatons hae government or Apple-sponsred ollection
and/or regding prograns for spent tatteries. Dispose bspent katteries in
accordance wih the mandabry or voluntary kattery ollection prograns
in your location. Contad your Apple-auhorized sevice povider or
informaion abouthe reommended diposl procedures in your area.

WARNING Damayed nickel-metal-lydride katteries may leak small
amounts & potassum hydroxide This sibstance @n cause seere buns
to the «in and g/es If you buch a damged kattery, immediatdy wash
your hands and any other affeded area with water br at lest five
minutes. Do nat use ap.

Power Management
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Maximizing the life of batteries

= If your PowerBook has one battery

If your PowerBook wses ore kattery you an maimize the life d your
battery ly dischaiging and then retiaging it comgdetdy once gery D0
days Jwst Lse he computer & you nomally would, but gnore he low-
power messages that apgar on lhe screen(Make sire b save your work,
however) When he computer ges © deep aubmaitcally after te final
warning, rechage te kattery @mpetdy before wsing it again.

= |f your PowerBook has two batteries
If you are sing two hatteries, svap he Idt and right batteries every nonth.

Your katteries will last longer if you redhage them at or kghty below room
temperature

With proper @re You @n exped your katteries © last for at leat ayear If
you notce hat he katteries no bnger hdd a dage for as long as they
shoud, you mg need b repace hem

Maximizing work time

Chapter 6

Your PowerBooKs katteries an provide up © 4 hours bwork time eab
before you reed 6 retaige The adual work ime availade depends on \mat
equipment youre Wlsng with your omputer ad what steps gu tale ©
consere paver while you work.

Ways to conserve battery power

You @n see hw efficienty your omputer § wsing the batteries by looking at
the tattery onauumpion rate n the Battery Monibr module d the Control
Strip. If you are sing battery sving featura, the meter shold pant to the
left.

Try some d the kattery sving featurs listed ow. The nore d these
featurs you wse the longer work time you get from your hatteries.

= Turn down the screen bghtress (¥:) whenever posible. At its brightest
level, the screen@naimes about atird o the paver your @mputer $
using.



= Keep screen dimmg on in the PowerBook cntrol panel. The lower
settngs dim your screen aomaitcally if you haerit used he mwmputer br
a few minutes

= Set the Battery @Wnsewaton dider in the PowerBook antrol pand to
Better @Wnsewaton. The rest d this setion describes these seiings in
detail.

= Keep vrtual menmory turned df in the Menory control panel.

» If your omputer ha 8 MB d memory or nore you @n use a RAM disk
as your statup dik to minimize had disk use (See ‘Seting Up a RAM
Dik” in Chapter 7dr more informaion)

= Quit any program hat tses a nodemas ©on & posible. As long & the
program s open, Your nrodem § onauming pover e/en if you are not
using the nodem

= If youre working near an dedrical outet, plug in the power adapter
= If you arett usng the computer put it b deep and dug in the paver

adapter
Adjusting the battery conservation settings

The Battery nsewvation setion d the PowerBook cntrol panel gives you
several vays © control your mmputels paver ongaumpion.

The easiest approach
Just se he Battery Wnsewaton dider b choose fhe setitng you préer.

Choose Control Panels from the Apple (@) menu, and open the PowerBook control panel
(or click the Power Settings module  in the Control Strip).

—

—1—]

PowerBook

The RFowerBook mntrol panel opens n Easy View. You @n ako dhoose
Custom View for more detailed opbns See “Chooing Custom Options
later n this chapter

Power Management
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Drag the slider to the setting you want.

E(=—— PFowerBook

Easy
Better o | Bt
Conserwation T 10 Perforrance

Custorn

There areifre setitngs. Better Rrformance albws you b work with the
fewest interruptions If you ant plug in the momputer Better Wnseraton
gives you the longest work time.

Close the PowerBook control panel.

If you dort use he mmputer ér several mnutes (hav many depends on
which seting you dhoose)it goes b deepwithout any adion on yur pat. A
computer h deep ha a darknred screenred appars ¢ be df, though it is
still using battery paver at a dw level if the paver adapters not pugged in.

Note hat a green djht flashes at he bp o your omputels disgay when te
computer § in deep

To put he omputer ¢ deep lefore he aubmaic deep seiing takes dfed,
choose &ep flom the $edal menuor use he Seep nodule in the Gontrol
Strip.

To wake the mmputer fom deep press any key.

Automatc deep des not take dfed under bhe following drcunmstances:

= YOou are sing an external nonitor.

» AppleTalk is tumed on n the Chooser rad the paver adapters dugged in.
= Your @mmputer $ mnneded b a shared dk on he retwork.

= Your mmputels seral pott is in use



More about automatic sleep

The Battery Wnsevation dider ontrols three paver mnseraton feature:
gystem seep screen dimnmig, and had disk sgn-down.

= System deep is a stateri which your omputer ses ony the paver it needs

to mantain the ontents ®RAM (such & awy open pograns and
documents and \arious @ntrol panel setings). Youll see a green gjht
flashing at he bp d the dspgay when he PowerBook is in deep

= Screen dmmning saves katterypower by aubmaitcally dimming your
PowerBooKs disday screenThe dispay screens ore d the man
consumers @ battery paver.

» Hard dsk goin-down stops your mmputeis intemal had disk from spnning

when it isrit being used. If he FowerBook is in deep then te had disk
aubmaically spns davn.

Notice here areifre setings on he Battery nsewation sider:

E(I=———— FowerBook
Easy
Better o | Bt
Conzervation T 1 Ferformance
Customn

The five settings in the Battery Conservation slider
indicate the time it takes for your computer to go to sleep,
the screen to dim, and the hard disk to spin down.

The ime it tales for eat feature ¢ tale dfed depends onhe setings you
choose If you dray the dider bward Better ®nsewation, it tales less ime
for the ystem b deep the had disk to spn dowvn, and the screend dim

The talbe indicates hav the kattery onsewaton setitngs amrrespond ¢ deep
times.

Minutes it takes if you choose

Conservation Performance
System sleeps 2 3 6 8 15
Hard disk spins down 1 2 3 6 8
Screen dims 1 2 3 4 5

Power Management
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This section... _|

...and this section
of the control panel

appear whenever

you click Custom. _|

| Power Conservation

Chapter 6

L] b

Choosing Custom options

For more opions hat dfed your mmputels paver @naimpion, hdd dovn
the Option key while you dick Customin the PowerBook control panel.

E(=——— FowerBook

Eazy
Better L Better i
Conservation C@? Performance __ C“Ck CUStom

Custorn

Minutes until:

Screen [ NN NN
Dvims T T
+1+2+4+5+15 Never +1+2+3+4+5 Mever

Systemn
Sleeps

Hard Disk  _tret 10011000
Options . .
B alow processor cycling - more battery savings Th|S section Of the Contr()l panel appEarS

only when you hold down the Option key
while clicking Custom.

@Aute  Teaveny b | (Default ]

Battery Conservation settings

The Battery Wnsewation dider works & described in the previous setion,
“Adjusting the Battery nseration Sttings” | n Custom iew, you @n ako
use hree fiders vhich control system teep screen dimnmig, and had disk
spn-downn. (For a decripion d ead feature see More About Automatc
Seepg in the previous setion)

E(=—— PowerBook

Easy
Better e | Btter =
Conzerwation T 1 Performmance =l

Custorn

Minutes until:

Screen
Dims

Sy stemn
Sleeps

Hard Disk
Spins Down 7

To wse he diders:

Choose Control Panels from the Apple (@) menu, and open the PowerBook control
panel. (Or, use the Power Settings module  in the Control Strip.)

Click the Custom button.



Drag to choose the settings you want.
The katteryconsewation sider rdlects the changes you male
Close the PowerBook control panel.

Processor cycling

If the mmputer $ not dong anything for a fw seonds it reduces the paver
consumpion d its microprocessor. The microprocessor comes badk up o
speed hstantaneowdy when you resume work. This feature $ alled
processor ¢ycling.

Processor oycdling consewes kattery paver. It is hghly reaommended hat you
work with processor ¢ycling on But if a piogram performs very sowly, you
can tum of processor gycling temporary. Follow these steps

Choose Control Panels from the Apple (@) menu, and open the PowerBook control
panel. (Or, use the Power Settings module  in the Control Strip.)

Hold down the Option key while you click the Custom button

Click the “Allow processor cycling” checkbox to remove the X.

Options
[<] éllow processor cycling - more battery savings

Close the PowerBook control panel.

To tum processor ¢yding bad on, dick the "Allow processor ¢yding”
chedkbax again.

You mg notice oher dfeds d processor ¢ycling. For examge, if prograns
are working in the badkground, pocessor ¢ycling may dow them davn. You
may also nofce hat he Alatmm Jock is updatedriregularly or that he
wristwatch pdnter apgars nore dten These danges do not indicate a
problem with your computer

IMPORTANT To consewe hattery paver, turn processor ¢ycling df only when
using prograrns that it interferes with. Turn processor ¢ycling badk on ajain as
soon & posible.

Power Management
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Power conservation

Your PowerBook keeps trak of what paver surce yu are ging and @an
change the paver mnsewvaton setitngs acordingly. To control aubmaitc
power onsevaton, follow these steps

1  Choose Control Panels from the Apple (@) menu, and open the PowerBook control
panel. (Or, use the Power Settings module in the Control Strip.)

2  Click the Custom button.

3 Click the Auto button.

Power Conservation
@ Auto
»Manual

[ Power Adapter v | (Default ]
Y

4 Selecta power source in the pop-up menu

Power Conservation
@ Auto p "
v Battery Default
C Manual _Pou.ler Adapter

5  Drag the sliders to the settings you want.

See he setion on Battery nsevaton setitngs for more relp.
6  Close the PowerBook control panel.

To use he preset paver onsewation setings, dick Defaut. To tum of
aubmaic pover mnsewaton, dick Manual.
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Read this chapter for help using
custom options on your PowerBook
and for tips on traveling and

storing your computer.

Customizing and Traveling
With Your PowerBook

Customizing your PowerBook

There are seeral ways you @n customize your FowerBook © male your
day-to-day work eaer:

Adjusting the trackpad ~ You @n adust the trac&pad and doulbe-dick speed n
the Tradkpad ©ntrol panel.

Reconnecting to shared disks I you use your FowerBook on a etwork to
conred to shared aks, the AutoRemounter ontrol panel lets you
recnred aubmaitcally.

Usinga RAM disk Using a RAM disk saves you ime and kattery pover.
When you create a RM disk, its mntents areaved in the S/stem elder
when you shut den your PowerBook and then ®pied badk to the RAM
disk the rext time you tum the computer on

Improving the pointer display ~ You @n set opgbns b male the panter nore
visble on he screen

Printing later  You @n set up douments 6 print the rext time you onned
to the network printer.

These feature are dscribed in the setions hat fllow.
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Adjusting the trackpad
You @n change te tra&kpadsetings it works better with your buch.

1  Choose Control Panels from the Apple (@) menu and open the Trackpad control panel.

Trackpad

2 Click the tracking speed you want.

Click a slower setting if you want the pointer to move
more slowly than your finger on the trackpad.

Click here if you Want_gmgi Trackpad

. Pod Tracking
the pointer to move at M 1) ®0 0000 —— Click a faster setting if you want the

a constant speed fiol  Slow Fast pointer to move more quickly than your
relative to the motion Double-Click Speed finger on the trackpad.
of your finger on the - * "
trackpad. HE- 0% o @Y

3 Click the double-clicking speed  you want.

Couble-Click Speed

_‘@_ Q-l- @Y Qt

Click here if your‘ | Click here if your

PowerBook often PowerBook often
interprets two clicks interprets a double click
as a double click. as two single clicks.

4 Close the Trackpad control panel.
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Automatically reconnecting to shared disks

Your PowerBook dsmnneds from any shared dks its mnneded b when
you tum it off or restatt it, or when it is in deep By using the
AutoRenounter your PowerBook @n remnned to shared dks aubmatcally
when you tum it badk on (or vake it from deep) In additon, if you onred a
hard disk to your PFowerBook while its in deep the had disk appears ontie
desktop when you wake it up

Choose Control Panels from the Apple (@) menu and open the AutoRemounter ~ control
panel.

¥z

—1—1

dutoRernounter
If you want to reconnect to shared disks only when you wake the computer from sleep,
click After Sleep.

If you want to re@nned when you restait the mmputer a well as dter deep
cick Always.

E=— AutoRemounter

@‘_,_E:Lj Remount Shared Disks :
(==l
@ After Sleep
O Alway s

) off

Connect To Disks By @
O Autarnatizally Remaounting
@ Alway s Entering Passwords

If you want the computer to ask for your password when you reconnect to shared disks,
click Always Entering Passwords; otherwise, click Automatically Remounting.

For better priracy and securityhave your omputer & for your pasword
before reonneding to shared dks

Close the AutoRemounter control panel.

Customizing And Traveling With Your PowerBook ‘ 7
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Setting up a RAM Disk

Using a RAM disk saves paver because it aoids wsng the FowerBooKs had
disk while you are unning the FowerBook from its kattery Any files tat are
copied b the RAM disk are sved in the System Blder on he had disk when
you shut den your PowerBook The rext time you stat up your PowerBook,
the files are opied bad to the RAM disk aubmatcally. This feature $ alled
aperdstent RAM disk. It allows you © use your RAM disk without haing to
rebuild it every ime you restait your RowerBook.

There arewo ways © set up a RM disk, depending on he anount d
memory in your computer The first way allows you © keep apficaton
prograns and files in RAM. The seond way—for maimum kattery
conseraton—allows you © use Your RAM disk as te statup dik.

To set up a RM disk, you reed at lest 6 MB d RAM in your computer

If you have less than 8 MB of memory

If you hae less than 8 MB d menmory, set up a RM disk that ontains te
apgications ad files you use nost.

Create a folder called “RAM Disk Backup.”

Put into the RAM Disk Backup folder your favorite application(s) and files you frequently
use.

Try to keep addibns b this folder b a mhimum

Select the RAM Disk Backup folder . Then choose Get Info from the File menu in the
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window.

Youll need b renember the sze d your RAM Disk Badkup folder Wite it
down if you reed b.

Choose Control Panels from the Apple (@) menu and open the Memory control panel.

(e

—1—]
Mernary




The Menory ocontrol panel appears

ECIE=———— Memory
Disk Cache Cache Size
Alweays On
Select Hard Drisk:
Wirtual Memary s Masiniash HE 4
o ivaiiabie on disk - 3M
= @ off A ailable built-in mernory @ 40+

Peteent of available memory
1o uze for a RAM disk:

a Rt Disk .
& @ on 0% S0% 100%
o ofe
RAM Dizk Size ZO4DK,
Use Defaults

Click the On button under RAM  Disk.
Drag the slider to set the percentage of memory to use for the RAM disk.

Adjust the sze D fit the oontents dyour RAM Disk Badkup folder Make
sure you albcate enogh RAM to fit the $ze d your folder, or you will have
to repeat his step

Close the Memory control panel and restart your PowerBook.
A RAM Disk iconappears on gur dektop
Copy the contents of your RAM Disk Backup folder to your RAM disk.

See “Using the RAM Disk” later in this section.

IMPORTANT When you reed 6 tum df the mmputer male sire you choose
Shut Down from the S$edal menu If you wse he paver svitch to tum off
your omputey you will lose he ontents 6the RAM disk.

Customizing And Traveling With Your PowerBook
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If you have at least 8 MB of memory

If your PowerBook ha 8 MB d menory or nore you @an set up a RM disk
that ontains the files nreededa stat up your FowerBook. This provides
maximum kattery onseraton.

Select the System Folder on your hard disk and choose Duplicate from the File menu
This create a blder alled §stem lder opy.
Remove any extra extensions, fonts, and control panels you don't use.

Make sure not © ddete he files alled Fnder and Sstem fom the S/stem
Folder @py, or the file called Assistant Todbax from the Extensons blder in
the §stem Felder.

Create a folder called “RAM Disk Backup.”

Put the System Folder copy, your favorite application program or programs, and files
you frequently use into the RAM  Disk Backup folder.

Try to keep addibns b this folder b a mhimum

Select the RAM Disk Backup folder. Then choose Get Info from the File menu in the
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window.

Choose Control Panels from the Apple (@) menu and open the Memory control panel.

i

—1—]
Mernakry




10
11

12

13

14

The Menory ocontrol panel appears

ECI=———— Memory
Dizk Cache Cache Size
Always On
Select Hard Disk:
Wirtual Memory s Masintosh HI w
O on Hrvaiiable on disk - 3M
= @ off Available built-in rernary @ <4+
Percent of available mematry
= RAM Disk to use for a RAM disk:
& g g:f 0% 50% 100%
RAM Dizk Size 2040k
Use Defaults

Click the On button under RAM  Disk.
Drag the slider to set the percentage of memory to use for the RAM disk.

Adjust the sze D fit the oontents dyour RAM Disk Badkup folder Make
sure you albcate enogh RAM to fit the $ze d your folder, or you will have
to repeat his step

Close the Memory control panel and restart your compulter.
A RAM Di<k icon appars on gur dektop
Copy the contents of your RAM  Disk Backup folder to your RAM  disk.

Choose Control Panels from the Apple (@) menu and open the Startup Disk  control
panel.

Select your RAM disk in the Startup Disk window and close the Startup Disk control
panel.

Choose Restart from the Special menu.

See “Using the RAM Disk” (the following section).

IMPORTANT When you reed b tum dof the mmputey male sure you doose
Shut Down from the S$edal menu If you wse he paver svitch to tum off
your ommputey you will lose he ontents 6the RAM disk.

Customizing And Traveling With Your PowerBook
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Using the RAM Disk

Start up the application programs and files on the RAM Disk while your PowerBook is
plugged into the power adapter.

Using the paver adapteraves your battery
Put your PowerBook to sleep.
Unplug the power adapter.

Your dacuments will ke loaded mto RAM when your PowerBook comes out
of Sleep

While you are running your PowerBook off the battery, try to avoid using any files that
are not on the RAM Disk.

When you save new files, save them to the RAM Disk.



Improving pointer display

You mg notice hat he panter ®metimes dsappears fom your FowerBooKs

screen Wen you nove te panter quckly. You @an set ypur tra&pad (or
external nouse) b have “traks’ so you @n always seelte panter on he

screen You do his in

the Mouwse ontrol panel.

Choose Control Panels from the Apple (&) menu and open the Mouse control panel.

ifE

Mouze

The following control

SO Mouse

Mouse Tracking

2 2
0 4
O DO000@

Wery Slow Slow Fast

A +* + —

|
& + o + @ + O
m Double-Click Speed

panel appears:

| The settings in this section control the tracking
speed of an external mouse. Change the tracking
speed of the trackpad in the Trackpad control panel.

L You can set the double-click speed here.

Mouse Tracks

LS
O 0®00

0ff Shart Laong

L You can set the pointer tracks here.

[ Thick I-bearn |

Click the mouse tracks length you want

To display a thicker I-beam on your PowerBook, click the checkbox labeled Thick I-beam.

This males the |-bea

m nore Vsible on dsfday screens

Close the Mouse control panel.

Customizing And Traveling With Your PowerBook
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Printing later

If you wse a Bstript laser prnter(such & a Laserwriter Po 600) on a
network, you @n set up douments 6 print the rext time you onred to the
network printer.

1 Choose Printin the application program you are using.
Click Print in the dialog box.
The following dialog box appears:

This document can not be printed at this
time on the printer "LaserlWriter" because the
printer is not available on the AppleTalk network.

[ Don'tPrint || Print Later ||

2  Click Print Later.

The rext time you onred to an AppleTalk network printer, this daument s
printed.
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Traveling with the PowerBook

The sfety instrudions n the first pat of this book ado appy when you are
traveling. In additon, note hese preauions:

Do not transpot your FowerBook while it is tumed on Put your mmputer
to deep or shut it daon before you nove it.

Transpot batteries either insde he mmputer or with the piotedive dider
covering the battery ontads Do not transpot unproteded atteries

Do not ciedk your mmputer a8 baggage Carry it with you.

Have security fficials manually insped your omputer ad diks if you do
not want to pass them tirough X-ray madines

Take the gstem sftware dgks that ame with your omputer wih you in
case You reed b ranstall gystem sftware

Be preparedat shav security dficials that your omputer $ working. Have
a dhaiged lattery or a paer adapter readto use

Some arlines mg restrict or prohibit the ise & computers flight. Credk
ahead o find out what restrictions if any, appy.

Take the recessary dug adapters if gure traveling oversea (You ma
need b use hem with the paver adapter You do not eed a vltage
trandormer. The paver adapteran handle O wlts to 260 wolts AC
(48 Hz b 62 Hz)

Ched the diegrans below to detemine which plug adaptersoull need, or
ask your travel agent.

Outlet Type Locations

@ @ United States, Canada, parts of Latin America, Japan, Korea,

the Philippines, Taiwan

@ Former Soviet Union, most of Europe, parts of Latin America,
the Middle East, parts of Africa, Hong Kong, India, most of South Asia
Mexico, United Kingdom, Ireland, Malaysia, Singapore,
parts of Africa
7\ China, Australia, New Zealand

Customizing And Traveling With Your PowerBook
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Storing the PowerBook

1
2
3

Save your work on a hard disk or floppy disks.
Choose Shut Down from the Special menu.
Close the display.

Recharge the battery or batteries.

Be aire your katteries are flly chaged if you are takig the computer paces
where you @nnot gug it in.

Store the computer in a cool, dry place.

Storgge temperaturs shold reman between 0°C and 40°C (between ®°F
and 04°F). Avoid learing the mmputer vihere temprature may be extreme
or urpredctade—in the trunk of a ar, for examge.

Service and support

Chapter 7

If your jomputer $ malfund¢ioning but das not appar b be ptysically
damaed, shut it darn (end leae the paver adapter lpgged in, if posible)
untl you @an et help.

If you knaw or susped that your mmputer $ plysically damaed, dsmnned
the paver adapterrenove the kattery and do not se he computer urit it
can be repaied.

See he sevice and suppott informaion that @ame with your omputer br
informaion about catmer asistance



Refer to this chapter for information
about connecting SCSI devices
and using your PowerBook

as a SCSI disk.

Using SCSI Devices

A SCSl deviceis any produd—induding had disk drives, CD-ROM drives,
sanners and printers—hat @mmuntates with your @wmputer ly means d
a standad dedronic interface (SCSl stands br Snall Computer $stem
Interface You an attat up b 6 SCS devicesto your omputer ly linking
them bgether in a dain that stats at ywur owmputels SCSl port.

The SCSl port on PowerBook computersaoks like this:

@: ——SCSl port icon

To conred a Sl device b the SCSI port on your FowerBook, you need @
Apple HDI-30 SCSI System GHe or eqivalent.
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Connreding SCSI devices to your PowerBook involves these steps:
= installing Loftware

= seting SCS ID numkbers

s cheding that he SCS chain is pioperly terminated

= conneding caldes

These steps are deribed in the following sedions

Installing software

Most SCSl devices come with oftware hat albws your omputer ®
communcate wit them These pograns are alled drivers (If no drivers
come with a deice then it deesrit need ay) To install a drver, follow the
instiuctions hat ame with the device

Setting SCSI ID numbers

Chapter 8

Ead device in aSCSl chain must hae a ungque ID numler between 1 ad 6
so the omputer an identfy it properly.

WARNING Using two or nore deices with the ame SCS| ID number
can cause Yur equpment b malfundion. You could lose nformaion
as a reult.

Your omputer ha the SCS ID number 7 and its intemal had disk has the
numkber Q

See he daumentaton that @ame with your SCS devices for informaion
about ID numkers ad hav to change them



The ID numkers ¢ Apple SCSl devices @n be set a follows
Make sure the SCSI device is turned off.

If the device & alreag part of a SCSl chain, male sure hat all deices in the
chain are tuned df, induding the cmmputer

Locate the ID number indicator and switch (usually on the back panel of the SCSI
device).

ID number indicator

P

/
ID number switch

Check the ID numbers of all the devices you want to connect.

If all the devices hare ungue ID numlers you @n cntinue wih the rext
sedion, “Chedking That he SCSI Chain Is Popelly Terminated.

If you need to change a device’s ID number, choose an available number between
1and 6.

Insert the end of a straightened paper clip into the small hole below the ID number.

Push repeatedly until the number you want appears.

Using SCSI Devices
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Checking that the SCSI chain is properly terminated

Chapter 8

To ensire acurate trasmssion d informaion, a ©iain of SCSl devices must
have a teminabr at eah end. €minabrs are bilt i nto sme TS devices
and @n ako be added eernally.

= Your PowerBooKs intemal had disk, which is the first device in the dhain,
has a bilt-i n teminabr. However, you shold ako add atemnal
terminabrs & described in these nstudions

s External SCSl devices from Apple do not hee built-i n teminabrs

s External SCSl devices from oher vendors mg have built-i n teminabrs;
see he dacumentaton that ame with the device

If you are attaching one SCSI device

Make sire hat here B
= an extemnal teminabr between he gstem alde and the SCSI deviceand
= ateminabr (intemal or external) on he SCSl device

If you are attaching more than one SCSI device

Make sure hat tere B

= ateminabr (intemal or external) on he last LS device;and

= No oher teminabrs (intemal or extemnal) or oher extemal devices in the
chain.

If you hare bo may devices with intemal teminabrs your Apple-
authorized sevice povider @n renove etra teminabrs

Chain configuraions are shan in the illustraton in step 6 bthe following
sedion.



Connecting cables

WARNING When making SCSI connedions always turn off power o all
devices in the dhain, induding your cmputer If you dort you could
lose hformaion and damage your equipment

Shut down your PowerBook and all ~ SCSI devices in the chain .
Connect an Apple HDI-30 SCSI System Cable to your computer.

Attadh the smaller endfahe @Hde o your mmputeis SCS port (marked
with the icon &).

If necessary, connect a terminator to the system cable.

If you are attauing only one SCSl device see e setion “If You Are
Attadching Ore SCSI Devicé' in “Cheding That he SCSl Chain Is Poperly
Teminated.

If you are attdzing more than ore SCSl device see “If You Are Attaching
More Than Ore SCSl Devic€ in “Cheding That he SCSI Chain Is Popeily
Teminated.

Connect the terminator or system cable to either port on the SCSI device.
To connect the next device, use a  SCSI peripheral interface cable .

Both ends arehie same Attadh ore wnnedor to the available SCSI port on
the first device and the other cnnedor to dther SCSl port on he rext
device

Using SCSI Devices
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Unless the last device has an internal terminator, connect a terminator to its remaining
port.

The illustraton shovs where b add ede teminabrs

Connecting one SCSI device

Terminator

\If this SCSI device has an internal
HDI-30 cable terminator, omit this external terminator.
Connecting more than one SCSI device

If this SCSI device has an internal
terminator, omit this external terminator.

HDI-30 cable ~ SCSI peripheral interface cables

IMPORTANT The tal lergth of a SCSI chain shoud not exceed 20 det
(6 meters) Apple SCSI caldes are ddgned b meet his restriction. If you are
using CSI cades from another vendor ched the lergth o the dain.

WARNING Once yur SCS devices are onreded, aways tum them on
before tuming on your PowerBook. If you tum the cmmputer onifst, it
may not ke able to stat up or it ma/ not reognize he TSl devices



Using your PowerBook as a SCSI disk

You @n purdase a ede alled he Apple HDI-30 SCSI Disk Adapterwhich
lets you onred your PowerBook © another momputer a a had disk. The
PowerBook appars ontie dektop d the oher mmputer a a had disk icon,
and you @n trander informaion between he cmputers ¥ dragging files
This feature $ @alled SCSl disk mode

WARNING Follow the stepsdr conreding and dsconneding SCS
devices cardully to avoid loss d informaion and damge © your
equpment.

Connecting your computer as a SCSI disk

Before makng any connedions you reed o assign a ungque Sl ID number
to the PowerBook

1  Choose Control Panels from the Apple (@) menu of your PowerBook computer.
2 Open the PowerBook Setup control panel

[ERY

—_——
FowerBook Setup

3 Inthe SCSI Disk Mode ID section of the control panel, click the ID number you want to
assign.

If you are onneding the PowerBook b an existing SCSl chain, male sire b
give it an ID numtler different fom those éthe oher devices.

<<.>=. SCS51 Disk Mode
Ib: (1 @z 3 (04 s e

4 Close the PowerBook Setup control panel.

5  Turn off the PowerBook by choosing Shut Down from the Special menu.
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10

Shut down the computer you are connecting to, and turn off other devices in the SCSI
chain.

Connect the PowerBook to the other computer or, if there are already devices attached,
to the end of the SCSI chain .

Remove the teminabr from the last device in an exising chain before
conneding the PowerBook

WARNING Always shut den the FowerBook before @nreding or
disoonreding the SCSl disk adapter ade. Conneding the adapterahe
while the momputer § tumed on en damae the computer

Turn on the PowerBook by pressing the power button.

After a Bw seonds aSCSI icon appears onlie screen, shwing the ID
number you asigned in step 3

3 cumm

WARNING If you do not seene SCSl icon, and the ammputer éher
statts nomally or disdays an error message, choose 8ut Down (if you
can) and then immediatdy disconned your mmputer fom the SCS
chain. If you @ant choose 8ut Down, try pressing the paver butbn.

If you @annot shut dan your PowerBook, you shold discmonred the
cabde anyway, or you mg lose nformaion. Then @ badk and repeat
steps 6hlrough 8

Turn on the other SCSI devices in the chain, if any.
Turn on the other computer.

The RPowerBook appars a a hatl disk icon on he screen fothe ammputer
you wnnreded it ©. You @n nawv tranger and wse fles @ if the RFowerBook
were a external dik drive.



Simplifying the SCSI disk connection process

If you regularly plan to use your PowerBook & a £S5l disk with the same
computey you @n leave the SCSl disk adapter alde attated b the oher
computer or its When you want to use your PowerBook & a £S5l disk,
smply shut devn all devices and mnred the adapterale to the SCSl port
on your PowerBook

These cables can stay attached to your
desktop Macintosh or its SCSI chain.

HDI-30 SCSI disk adapter ~ Connect and disconnect your computer here.

WARNING Always dsmnred your FowerBook from the adapteratle
when you are not sing it as a £9 disk. Your PowerBook will not
work corredly if the adapteratde remains attabed.

Drawing battery power in SCSI disk mode

Your PowerBook mntinues © drav battery paver when you wse it & a £
disk. Low battery pover is indicated ly a Hinking low-power waming on he
PowerBooKs screen

If you seehis waming while using your omputer a a £3l disk, ether dug
in the paver adapter or uSCS disk mode as described in the next sedion,
S0 you @n renove the kattery br redaging.
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Quitting SCSI disk mode

Chapter 8

1
2
3

Shut down the computer your PowerBook is connected to.
Tap the Power On ( @) key once to turn the PowerBook off.
Turn off any other SCSI devices in the chain.

Disconnect the PowerBook from the adapter cable.

If you regularly plan to conned your FowerBook b the same computer you
can leave the adapterale attabed b the SCSl chain or the oher cmputer
See ‘Smplifyi ng the SCSl Disk Connedion Pocess” in “Using Your
PowerBook & a &3 Disk,” eallier in this dapter

IMPORTANT Do not le@e the adapterale attabed b the PowerBook If you
da the mmputer will kehave & though it is stll i n SCS disk mode when you
try to restat.

If necessary, disconnect the adapter cable from the other computer or its SCSI chain.

Your equpment s nav read for nomal tse Make sure hat he SCSl chain
is popeiy teminated.



Refer to this chapter if you want to
use an external monitor in addition
to the built-in PowerBook display.

Using an External Monitor

Your PowerBook ha avideo pot to which you @an conned most Apple
monitors Contad your Apple-auhorized dealerdr informaion on vhich
monitors are ompatble with your FowerBook

To conred an external nonitor, you reed he FowerBook video adapteratle
that mmes with your omputer

Your PowerBook ako auppotts nost VGA monitors To conned a VGA
monitor, you reed & adapter alde, which shoud come from the same urce
as the nonitor.

An extemal monitor conneded b your mmputer en fundion & an extenson
of your PowerBooKs built-i n screen-that i, you @n dray oljeds from ore
screenda another and do yur work on éther ore Or you @n shav the same
image on bol screens
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Connecting an external monitor

Chapter 9

To conred a nonitor, follow these steps(If you are onneding a nonitor
from a maufadurer oher than Apple, be sire b read its maual)

Choose Shut Down or Sleep from the Special menu.

If you cnned a nonitor with your computer tuned on, he computer will
not remgnize he nonitor.

Plug in the power adapter that came with your PowerBook.
You must ulse he paver adaptewhenever you are ging an extemal nonitor.
Place the monitor where you will be using it.

Keep he ommputer ad the nonitor at leat 8 nches apat to avoid
interference btween he nonitor and your mmputeis floppy disk drive,
which aan cause erors on pur floppy diks.

=

8 inches minimum

Floppy drive

Arrange the nonitor 2 the bp d the screend dightly below eye level while
you work. Podtion the nonitor to minimize dare and rdlections on he
screen fom lights and windows

Make sure the monitor's power cord is attached to the monitor, then plug the other end
into a grounded outlet or power strip.

If your nonitors paver cord is deigned b plug into the paver receptde on
the badk of a mmputey rather than into an dedrical outet, you @n obtan a
cabe with the mrred plug from your Apple-autorized dealer

If you are sing apower strip male sure it is tumed on



5  Attach one end of the video cable to the monitor and tighten the thumbscrews.
(Some nonitors hae an attated vdeo @lde)

6  Attach the other end of the video cable to the PowerBook's video adapter.

7  Attach the other end of the video adapter to the  video port (IOI) on the computer’s back
panel.

H@ H—Video port icon
%—Video port

8  Turn on the external monitor.

9  Pressthe Power On key to turn on or wake your computer.
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Trouble?

= Nothing happened when you tried to turn on the PowerBook.

Make sure hat all your egipment s @nneded popetly, and try presing
the Power On ley again.

Make sure hat he paver adapterd dugged into boh the omputer ad an
eledrical outet. If you are ging a paver strip male sure it is tumed on

= The computer is on, but the external monitor is dark.

Make sure hat he nonitors paver cord is ®nneded, and that its paver
switch is on Try adusting the nonitors brightness and @ntrast setings. If
this daesrit work, try restating your omputer

Activating the external monitor

You must adivate he ecternal nonitor ead ime you onred it to your
computer h order b wse it.

1  Choose Control Panels from the Apple (@) menu, and open the Monitors control panel

Youll see wo redangles repreening your wo monitors

2  Click the rectangle 1 (representing your external monitor).
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Displaying the menu bar on the external monitor
To dispgay the menu lar on he extemal nonitor, follow these steps
1  Choose Control Panels from the Apple (@) menu, and open the Monitors control panel

Youll see wo redangles reprsentng your wo monitors

2  Drag the menu bar from rectangle 2 (representing your PowerBook screen) to rectangle 1
(representing your external monitor).

3 Close the Monitors control panel.

The menu tar apgars on gur extemal nonitor.

Trouble?

= The computer is on, and the external monitor looks like it's on, but the screen is
blank.

You must atdivate he ectemal nonitor ead ime you onred it to your
computer See Activating the Exemal Monior”
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Working with an external monitor

Chapter 9

This setion simmarize hav your omputer ad extemnal nonitor behave
when you use hem bgether.

Sleep

The PowerBook will not deep when an extemal nonitor is onneded. If you
are ng an extemnal nonitor, its a god dea b leave processor ¢ycling
turned on (You change piocessor ¢ycling opions n the PowerBook @ntrol
panel. See Chapter 6of help)

Backlight dimming

The dimming feature in the FowerBook wntrol panel turns he screen
brightness dawvn to a bw level when you haerit used he computer ér a fw
minutes. (You @n think of dimming as “screen leep’)

Dimming ako dfeds the external nonitor. When you nove your finger on
the tra&pad or pres a ley on he keyboad, the brghtress is restored on bdt
screensSee Chapter 6or more informaion on adlight dimming.



Using a monitor for presentations

Once pu hae attabed a external nonitor to your FowerBook, you @an use
that nonitor to shav whatever is dsdayed on yur bult-i n dispay. This
“video mrroring” capalility i s is€ful when youre makng a preentaion b a
group You tum video mrroring on or df in two paces:

= the Video Mirroring module in the Gontrol Strip (See Chapter Sof
instructions on sing the Gontrol Strip)

» the PowerBook Disday control panel
To use he PowerBook Disday control panel:

1  Choose Control Panels from the Apple (@) menu and open the PowerBook Display
control panel.

FPowerBook [visplay

2 Click the On button under Video Mirroring.

E0=———= PowerBook Display

\idea Mirroring
F @ on
) off

3 Toturn off video mirroring later , click Off.
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Disconnecting an external monitor

Chapter 9

1

Make sure your computer is shut down or in sleep.

If you dismnned the nonitor while your computer $ on, he cwmputer will
turn itsdf off, and you will lose ay informaion you dd not sve

Disconnect the video adapter fromthe  video port on the computer's back panel. The
video port is marked with thisicon: 10

Press the small butbns on bdt 9des d the mnnedor © renove the video
adapter fom te pot.




Refer to this chapter when you want
to expand your PowerBook system
with additional devices or memory.

Connecting Other Devices

The badk panel of your omputer ha seeral ports for conneding other
devices:

Modem port
(optional)

Security slot
< SCSiI port (HDI-30)

I3l Video port
<> Ethernet port
£l /% Modem/Printer port

~ Power adapter port
< Apple Desktop Bus (ADB) port

¥ Sound input port  ¢)) Sound output port

ecccce
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Connecting a modem

If your omputer ha an intemal nodem see he dacumentaton that ame
with your nrodem br more informaion.

You @n ako conned an external modem b the seral pott on the badk panel
of the mmputer

To conred an extemal nodem follow these steps
1 Make sure the computer is in sleep or shut down.
2  Connect the modem to a power source and to the phone line.
See he dacumentaton that @ame with the nodem
3 Make sure the modem is turned off.

4 Connect the modem cable to the serial port marked with this icon:

5  Turn on the modem.

6  Wake orrestart the computer.

7 Choose Control Panels from the Apple (@) menu and open the PowerBook Setup control

panel.

——
FowerBook Setup

8  Click the Normal button.

|§D§_ PowerBook Setup

i g
‘

Modem

D Cormpatible @ MNormal
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9  Close the control panel.

The extemal modem & read to use If you hae pooblems cnreding to the
extemnal nodem #dter following these stepsrepeat steps lhrough 7 and then
choose ©@mpatble instead bNormal in the FowerBook Setup ontrol panel.

If you have boh an intemal and an external nodem remember o sded the
modem yu want 1o use n the PowerBook Stup ontrol panel before
opening your tdecommuncatons pogram

Connecting a printer

The seral pott on your @mputer an acept éher a dred connedion (b a
printer sich as the SyleWriter) or a retwork connedion (b a priter sich as
a LaserWiter). The serial pott is marled with this icon:

Dy
3

Some printers induding the Reronal LaserWiter SC, are onneded hrough
the SCSI port (marked with the icon <). You @n ako conned your
PowerBook © a printer with an Ethemet pott. See “Gonneding Diredly to
Your Printer With Ethemet’ in Chapter 1 for instructions

Follow the instiuctions hat @ame with your printer b conred it to your
computer

Connecting Other Devices ‘ 107



108

Connecting a mouse or other ADB device

Your ommputer ha ore Apple Desktop Bus (ADB) port, to which you @n
conned low-power input devices (such as a nouse). The ADB port has this
icon: . Conned ADB devices ony when your PowerBook is df or in deep

Make sure hat any such devices you @nned are deigned for pottade
computers Sandad ADB devices mg drain your kattery \ery quckly, even
if the paver adapters dugged in. Low-power devices are markd with this
icon: ©. You @n attad up b three deices in a dain to the ADB port. See
the instructions hat @ame with your ADB device or dgices for informaion
about heir powver mnsimpion, axd male sure hat he btal paver dravn by
all devices youre mnneding does not &ceed 20 mA

Using sound input and output devices

Chapter 10

Sound input devices

Your cmputer ha a biit-i n microphore centered jst below the dsday. The
microphore is @wntrolled by the piogram you wse b re@rd sounds (Sound
rearding is described in the dhapter on sund h the Macintosh Reference
book)

Microphone




In additon b its intemal microphore, your FowerBook ha a stere@ound
input pott (marked with this icon: ¢) to which you @n connred an external
sound nput device hat povides line-level output.

You @nnot wse boh the intemal microphore and an exteral ©und nput
device at he same ime You @n sdect a ®und deice in the Sund ontrol
pand (see he Macintosh Reference book)

WARNING Do not pug a ®und output déce (sich as a pai of
headphoes) into the ©und nput pott. Doing Mg damae your
audb equpment.

Sound output devices

The RowerBook ako has a stere@ound output pdr(marked with the icon «))
to which you @n conred spealers an ampifier, headphoms, or oher audo
output deices. The und output pdracepts a stadad stereo miiplug,
like that tsed b attat headphomls © a potale tape gayer.
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Adding memory to your computer

Your PowerBook computer omes with at leat 4 MB d RAM. By adding
memory upgrade eardsyou @n increae Your omputeis menmory. You @an
find out hev mudh menory your omputer ha by choosng About This
Madntoshfrom te Apple (&) menu in the Finder

You @n purdiase nenory upgrades from Apple-autorized dealers

WARNING To avoid damage © your PowerBook, Apple re@mmends hat
only an Apple-cettified tednician install additonal RAM. Conault the
senice and suppott informaion that @ame with your cmmputer ér
instructions on hw to contad an Apple-autorized sevice povider or
Apple for sewice If you attemptd install additonal RAM yourséf, any
damae you mg cawse b your equpment will not ke mvered ly the
limited warranty on your mmputer See an Apple-autorized dealer or
sewice povider br additonal informaion abouthis or awy other
warranty queston.

Your PowerBook computer ado suppotts virtual memory, a eature lhat
makes se ¢ hard disk spaced provide additonal RAM. See he Macintosh
Reference book or more informaion.
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Read this chapter when you
want to take advantage of
your PowerBook’s built-in

Ethernet capability.

Using Your PowerBook With Ethernet

Connecting your PowerBook to Ethernet

Ethemet networkYour RowerBook mmes with a biilt-i n Apple Ethernet pott.
You @n cnred to high-speed Ehemet retworks b acess a \ariety d
networking sewices. To conned your RowerBook © an Ethernet retwork,
you reed & Ethemet adapteend @be. Several BEheret adapters are siva
below. See yur Apple-auhorized dealer oretwork admhnistrabr for more
informaion on Apple Ethemet adaptersofr your FowerBook.

Apple Ethernet Apple Ethernet Apple Ethernet
thin coax transceiver AUl adapter twisted-pair transceiver
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IMPORTANT You @n conned your FowerBook © any standad Ethernet
network. The bdlt-i n Ethemet sippots EtherTalk Phase 2 (AopleTalk
Phae 2 potocols for Ethemet networks). The bult-i n Ethemet daes not
suppott EtherTalk Phae 1 (AopleTalk Phae 1 potocols for Etheret
networks). You @n ako purdisse poduds that albw you © communcate
over Bhemet wsng other piotocals, such as MacTCP.

There arewo ways © conned your FowerBook © an Ethemet rnetwork:

s Conred the PowerBook between oher devices in a retwork.
= Conred the PowerBook © the end 6 an existing network.

Connecting your PowerBook between two devices on an Ethernet network

When you mnned the FowerBook between wo desices on a etwork, you
may need b bridly interupt ommuncation between retwork users on bdt
sdes d the wnredion. Be sire b nofify users lefore adding the PowerBook
to the retwork.

O

1  Plug the cable on your Apple  Ethernet adapter into the Ethernet port on the PowerBook.

The Bhemet pot has tis icon: «»

Chapter 11



2  Disconnect one Ethernet cable from the network device immediately to the left or right
side of the PowerBook.

3 Plug an Ethernet cable into the socket you have just freed and into the PowerBook's
Ethernet adapter.

4 Plugthe Ethernet cable you disconnected in step 2 into the remaining socket of the
PowerBook’s adapter.

5  Turn on EtherTalk in the Network control panel.

See he Macintosh Reference book for help using the Netvork control panel.

Connecting your PowerBook to the end of an Ethernet network

Conreding the PowerBook b the end da network will not interupt
communtaton anong network users

1  Plug the cable on your Apple  Ethernet adapter into the Ethernet port on the PowerBook.

2 Use an Ethernet cable to connect the adapter to the network as shown.

]

0

3 Turn on EtherTalk in the Network control panel.

Using Your PowerBook With Ethernet
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Connecting directly to your printer with Ethernet

Chapter 11

You @n conned your PowerBook © any printer with an Ethemet pot.
Plug the cable on your Apple  Ethernet adapter into the Ethernet port on the PowerBook.
Plug an Ethernet adapter into the  Ethernet port on your printer.

Connect the two adapters with an  Ethernet cable , as shown.

—

-3




Refer to this chapter for solutions
to some common problems.

Tips and Troubleshooting

This dhapter dscribes posible causes and lutions br ssme cmmon
problems you ma have with your FowerBook or asociated eqipment
provided ly Apple. Try the posible solutions n the oder hey are Isted unit
the poblem is ©lved. Cled the spedfic set¢ions n this book ad in the
Macintosh Reference book or additonal Felp.

WARNING If you hae a poblem with your FowerBook and nohing
presentedm this chapter or i the manuals that @ame with your
computer slves it, consllt the sevice and suppott informaion that
came with your omputer or instructions on hw to contad an
Apple-auhorized sevice povider or Apple for essistance If you
attempt o repar the mmputer pursdf, any damae you mg cawse b
the omputer will not fe cvered ly the limited warranty on your
computer Contad an Apple-autorized dealer or seice povider or
addiional informaion abouthis or ay other warranty question.
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The PowerBook

Chapter 12

The computer won't start .

The computer mg be on, buthe screen bghtness or @ntrast mg be
turned davn. Adjust the brghtness and ontrast @wntrols.

The kattery or latteries may be draned. Rug in the paver adaptemait 15
minutes, and ten try b tum on he cmputer

There m& be a temporary pblem with the computels paver g/stem
Hold dowvn the Gontrol, Option, ¢ (Command), and Power On (D) keys
at the same ime, and ten try b tum the cmputer on gain.

The computer just stopped .

The computer mg have gone © deep (If a green [ht flashes at he p
of the disgay, the ammputer § in deep) Press any key on the keyboad to
wake the coomputer

The kattery mg have draned ® far that he @wmputer ha put itsé to
deep b proted the ontents ®RAM. Pug in the paver adaptemait 15
minutes, and ten tun the omputer on gain.

The computer mg have “crashed’ due b temporary aftware poblems.
Hold dovn the Gontrol, # (Command), and Power On (D) keys at the same
time and then try b tum the computer on gain. You will lose ay work
you hae not sved.

The computer won't restart.

Try to restat your omputer gsing ore d the following methods Try them in
the oder given

Press the Qontrol, $¢ (Command), and Rower On (D) keys at he saame ime

Restatting the cmputer his way does not &fed your RAM disk (if you
created oa) or its ontents

Hold dowvn the Gontrol, Option, 3 (Command), and Fower On (D) keys at
the same ime

Restatting the computer his way erases the mntents ba RAM disk.



= If you stll cant restat, try restating from a foppy disk.
1 Inset the Disk Tools disk into the floppy disk drive
2. Press the Fower On (D) key.

If the mmputer rstaits from a foppy disk, there & pobaldy a pooblem
with your had disk. You mg be alle to fix the poblem yoursdf (using the
Disk Frst Aid program or aother dik repar program; seehte Macintosh
Reference book or help). Or you ma prefer b take the computer o your
Apple-auhorized sevice povider

The computer is very hot .

= Itis nomal for the mmputer © be warmm to the bud while you are sing
it, espedally on he sde keneah the keyboad. If the momputer seem
unuwsually hot, try the following:

= plug in the paver adapter

» turn down the screen bghtness (%:)

= turn on kadlight dimming

= Use he Better @nsewation seting in the PowerBook antrol panel

= Make sure pocessor gycling is tumed on n the PowerBook wntrol
panel

» dismnred the external nonitor
= put the mmputer b deep or shut it dan

See Chapter 6of more informaion on redidng your mmputels paver
congsumpion.

The computer exhibits odd behavior, such as many unexplained system failures

= A comnmon awse d unexplained poblems is mutiple System elders on
your omputels statup dsk. The Sstem elder hat he RowerBook is
using to operate $ marked with a sgdal icon.

Sy=stermn Folder

Use he And command in the Fle menu b locate any other S/stem
Folders and dray them b the Trash
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You mg have a vruson your had dik. Use a rus-detetion pogram o
ched all your diks, and diminate ay viruses the program fnds

You mg be wing a pogram hats not ompatble with your @mputeis
gystem sftware Ched the informaion that ame with the plogram or
contad the manufadurer.

You mg have added aantrol panel or g/stem atengon that s
incompatble with other piograns you wse Restartt the computer wih the
Shift key held dovn unil you seehe message “Extensons df” in the
Welcome b Madntosh screenlf the pioblem dces not recurrenove any
such itens you recerly installed.

You mg need b ranstall ystem sftware See Appendix A for
instructions on nstalling s/stem sftware

The battery is draining too fast.

Look at he kattery onsuumpion rate n the Battery Monibr module o the
Control Strip. If the qauwge is © the right, then your mmputer $ wnauming
battery pover at a rajul rate

Turn down the screen bghtness, tum df virtual menory, use te Better
Consevation setitng in the FowerBook control panel, or work with the
power adapter ljpgged in.

You mg be wsng an input device (si1ch as a nouse ntended ér dektop
Madntosh gstens) not daigned br PowerBooks. Make sure b use ony
low-power input devices (marked wit the icon ©).

Your computer gpgies paver o the nodem vhenever a ommuncatons
program s oen Qut your ommuncatons pogram if you arett using it.

If you arett usng network sewices, you @n ako sve paver by turning off
AppleTalk in the Chooser omi the AppleTalk Swvitch module o the
Control Strip.

Your kattery mg need b be dischaiged and rehaiged ompetdy.

Older PowerBook hatteries do not htd a diaige & well as rew ones. You
may need b redace he kattery



The screen

The battery can't be recharged .

There m# be a bose onnedion. Take the tattery out ad put it lad in
the cmmputer and male sure he paver adapters popery plugged in.

If all conredions are OKthen he hattery 5 piobaldy damaed or dead.
Obtan a repacenent kattery fom your Apple-auhorized dealer

The computer goes to sleep too often.

Open he PowerBook wntrol panel and nove the tattery onseraton
dider bward Better Rerformance or iloose Rtter Rerformance n the
Power Setings nodule o the Gontrol Strip.

The computer doesn’t go to sleep automatically

You my have sdéected “never” on he Sstem &ep $ider in the Custom
sedion d the PowerBook cntrol panel. Drag the dider b a bwer seting.

You mg be mnneded b a shared dk on the retwork.

The seral pott may be in use ly a tdecommuntations pogram or a
printer

One or nore apgicaions mg be dang work in the badkground. You @n
choose &&ep flom the Sedal menu b override hem

The computer des not @ o deep if AppleTalk is ative and the paver
supdy is dugged in. Turn AppleTalk off in the AppleTalk Switch module
in the Gontrol Strip.

See Chapter 6of more informaion about htteries and paver onsumpion.

The screen is too dark.

= When you first tum on your mmputery it may take s&eral minutes for the

screen bghtness © “wam ug’ espedally if youve cosen a lgh seting.

The screen bghtness or ontrast ma not be optmal for the surrounding
lighting. Adjust the brightress (%) or ontrast (D) settng.
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= The screen dimaubmatcally when he atteries stat to run low. You my
need b redaige or repace he katteries before you @n tum up he
brightness.

= Screen dimmmng ma be on Press awy key or bud the trakpad b restore
the screes brightness,

The screen is flickering .

= This poblem osmetimes occurs when your screend set ¢ disgay the
maximum numler d colors or grgs Try adusting the @ntrast control, or
sdect fewer wlors or grgs in the Monitors ontrol panel.

The pointer moves too fast or too slowly

= You reed b adust the panters traking speed. pen he Tradkpad ontrol
panel (or Mouse ontrol panel if you hae a nouse onneded b your
PowerBook) and choose a mre mmfortale seting.

The pointer won't move at all.

= A software ppblem mg hare aused he mmputer ¢ “freeze” Hold dowvn
the Qontral, 3¢ (Command), and Fower On (D) keys at he same ime You
will | ose ay work you hae not sved.

A window has disappeared .

= Another open window on he dektop my have wvered he window youre
looking for. Move, resize, dose or hide windows you arett using unfl you
see he ore you want.

= Windows belonging to open but hadive piograns mg be hidden Choose
Show All from the Application menu (in the upger right-hand orner o
the dektop)to shav hidden whdows

An icon is blinking in the menu bar

= One d your piograns reeds pur attenion. For examge, you mg have set
the Alam Clock to go off at a paticular ime, or PrintMonitor may be
alerting you © a printing problem. Make the piogram ative and tale the
necessary adion.



Memory

SCSI devices

A “not enough memory” message appears when you try to open a program

Quit any prograns you areit using, then try ggain to open te piogram you
want. If that daesrit work, restait the omputer Sometimes restaring
makes additonal memory availale.

If you are sing aRAM disk or a d&k cadche, reduce its &ze and then
restait the ommputer

Use atra space ongur had disk as virtual memory to increae he
amount d memory availade for opening prograns. (Use vrtual menory
only when te paver adapters dugged in) You @n tum on vrtual
memory in the Menory control panel.

If you oongstenty want to open nore pograns than menory allows, you
can purdiase a nenory expandon ard from your Apple-autorized dealer

You can't turn on the computer after connecting a SCSI device.

SCSl devices mnneded b your omputer mst be tumed on lefore he
computer itsi. Turn on he SCS device(s) frst and then tun on he
computer

The computer doesn’t recognize your SCSI devices

When onreding SCSl equpment it is impotant to use te right abdes
and the @rred numter and dacenent d cale teminabrs Ched the
cales and teminabrs in the SCS chain and male sure hat all @des are
firmly attatied.

The devices ma be df. Ched to male sure hat tey are pugged in and
turned on

When te omputer $ in SCS disk mode tap he Power On (D) key to
turn the PowerBook df, and then try b tum the computer on gain.

If the device & a d&k drive, it may need o be initialized kefore you @n use
it. See he instudions hat @ame with the device

Tips and Troubleshooting
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= The ftware (drver) reededd communtate wit the device mg not ke
installed h your §ystem felder. See he instuctions hat ame with the
device

= Two or nore deices in the SCSl chain may have the same ID numler.
Chedk the ID numler d ead device b male sure eab ore ha its avn
numter ketwveen 1 ad § and change any numbers hat are not umjue

See Chapter 8of help using SCSl devices.

External monitors

The external monitor is dark.

= Screen dimmmg ma/ be on Pres any key or bud the tra&kpad butbn ©
restore he screen brightress

= There mg be no paever © the nonitor. Make sure hat he nonitors paver
cord is mnneded, and that its pever svitch is on

= Try adustng the nonitors brghtress and ontrast ontrols

The external monitor looks like it's on, but the screen is blank.

= The omputels paver adapter mat be dugged in when you wse a
extemal nonitor. With the wmputer n deep or shut den, gug in the
power adapter iad then wake or star up the RowerBook

» Ched to male sure he video @de conredion is secure

Disk drives and disks
The computer won't start up from the hard disk, or the hard disk icon doesn’t appear on
the desktop.

= There mg have been a temporaryotware poblem. Shut dawvn the
computey wait at least D seonds and ten tun it on aain.

= There mg be a poblem with the g/stem sftware on he had disk. You
can try wo things:
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= Start up he computer wih the Disk Tools disk. If the had dik’s icon
appears ranstall ystem sftware & described in Appendix A Disk
repar prograns @n ako ometimes fix problems with the had disk.

» Restatt the omputer hdding the Shift key down, untl you seette
message “Extensons df.” If this ©lves the pioblem, drag any control
panels or xtengons You recerly installed ¢ the Trash

» The informaion on he dik drive mg be damged. Ty using a dik repar
program b repar or re@ver the informaion. If this dcesrit work, youll
need o ranitialize he had dik. See he Macintosh Reference book

= There mg be a nedchanical problem with the dik drive If none d the
above suggestons works, take the mmputer 6 an Apple-auhorized sevice
provider.

The hard disk keeps stopping and starting again

» The had disk may be going to deep b consere pawer. If this is
interfering with your work, use he Better Rerformance sefing in the
PowerBook cntrol panel.

The hard disk is full .

= You @n redaim space ongur had disk by removing unreeded ifes;
installing a smallercustomized §stem felder; tuning off virtual
menory; or leng a dsk optmizaton or fle compression piogram

The icon of a floppy disk doesn't appear on the screen

s There mg be a poblem with the dsk or disk drive Try inseting a
different dgk. If its icon dces appar the orginal dik is piobady damaed
or mgy need b be initialized. You ma be alte to repar the disk or reover
some d the informaion on it. £e he the Macintosh Reference book If the
icon d the seond dik does not appar éher, the disk drive ma be
damaed. e an Apple-auhorized sevice povider Pr repatr.

» Restat the omputer hdding the Shift key down, untl you seetie
message “Extensons df.” If t his olves the pioblem, drag any control
panels or extengons you recerly installed ¢ the Trash

Tips and Troubleshooting
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A high-density (1.4 MB) disk you use with your PowerBook computer is not recognized
by another computer .

Some dik drives @annot reognize hgh-dengty disks Try inseting an
800K or 400K dik in the disk drive d the oher Madntosh If that works,
copy your files b an 800K disk or a DOK disk. If you reguladly plan to use
floppy disk drives d different tyges, use he lowercapadty disks in all
drives.

You can't eject a disk from a floppy disk drive

There m# be a temporary ethanical problem with the disk drive Restait
the ommputer ad hdd down the tra&pad butbn while the @mputer stas
up If that deesrit work, cardully inset the end da straghtered pajer dip
into the small hte near he dik driveés opening, and pwsh gnty unil the
dik is ejeted.

A message says that a disk is not initialized—but you know that it is.

The dik may not ke seated mpeily in the dik drive Ejed it and try
inseting it egain.

The disk may be damaed. If you inset another dik in the drive and the
message dces not appar the orginal disk probally needs repai See he
Macintosh Reference book If the seond dik is ako not reognized, he disk
drive mg be damged. e an Apple-auhorized sevice povider Pr
repar.

The disk may use a érmat hat he Madntosh @nnot reognize You @n

use PC Eghange (see ppendix C) b trandate ®me diks and file
formats

Restartt the mmputer hdding the Shift key down, untl you seehe
message “Extensons df” If this ©lves the pioblem, dray any control
panels or extengons You recerly installed ¢ the Trash

You can't delete a file on a floppy disk

The disk may be locked Unlock it by diding the tab s that it @vers he
hde at he @mrner d the dik.

The file may be locked. You @n unbck it in its Info window (choose Get
Info from the Fle menu) Or you @n hdd down the Option key while you
choose Enpty Trash from the $edal menu

= An appicaton piogram ma be wing the file. Qut the program and try

again.



Modems

Printers

You can't save or copy files onto a floppy disk

» The disk may be locked Unlock it by diding the tab s that it cvers he
hde at he @mrner d the dik.

= The disk may be ful. Delete fles you no bnger need or ge a diferent
disk.

See he Macintosh Reference book for more informaion about werking with
disk drives and diks.

The external modem doesn’t work

= The nodem mg be tumed df or impropedy conneded. Make aure it is
turned on ad that all ®nredions are orred.

= The nodem pot may not ke adivated. Qpen he PowerBook Stup ontrol
panel and male suire hat Normal is sdected.

The internal modem doesn't work

» The intemal nrodem mg not ke adivated. pen he RowerBook Setup
control panel and malke sure hat @mpaitble is séected.

See he nodem maual and the instrudions hat @ame with your
communtatons pogram br more informaion about @ng and olving
problems with your nodem

Your computer can't find the printer.
» The printer mg be tumed df. Turn it on

= The printer mg not ke sdéected in the ChooserOpen the Chooser ad
sded the printer you want to use

s Make sure hat he printer s onneded b the same pot sdected in the
Chooser

Tips and Troubleshooting
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Your printer does not appear inthe  Chooser window.

= The printer mg not ke mnneded poperdy. Chedk the mnnedions
between yur omputer ad te printer, induding rdevant setions d the
network if appopriate

= The printer ®ftware mg not ke in your §stem elder. Install he oftware
that ame with your printer or gstem sftware update

= AppleTalk must be adive before you @n use a etwork printer Make sire
that AppleTalk is adive in the Chooser

= If your network ha zores, the printer you want mgy not ke in the curenty
sdected zore Make sire he wrred zore is séected.

The network printer keeps restarting.

= Someore on he retwork may be wsing a diferent erson d the printer
software BEveryone mnneded b a retwork should use he saame printer
software \ergon. Consullt the network admhistrabr for more informaion.

Nothing happens, or you see an error message , when you try to print.

= The printer mg not be tumed on Make sure it is tumed on ad warmed
up

= The printer mg be out é paper or hae osme oter poblem. Ched the
printer stats lights and any messages on yur screen

= Turn the printer df for at leat D seonds Then tumn it on a@ain, wait for it
to warm up and try © print again.

= There mg not be enogh menory to print. QLit programs you areti using
and try aain.

Your documents are printed with the wrong fonts

= The printer mg not hae your fonts n its menory. You my be abde to add
the recessary fonts b your printer (seehe Macintosh Reference book) or
print on a diferent priiter hat ha te fonts you want. If you hae a
LaserWriter, you @n tum dof Font Substtution in the Rige Stup dalog
baox.

See he Macintosh Reference book for gereral informaion about pmting
documents See he printer manual for more informaion about pur printefs
featurs or poblems with the printed output.



Networks

You can't find or can't open icons needed to set up file sharing.

One or nore fles my be in the wrong place Make sure hat he Sharing
Setup fle is in the Gontrol Panels folder, and that he Fle Sharing
Extengon file, the Netvork Extenson file, and the AppleShare fle are n
the Exengons blder (Both folders arensde he §stem lder)

Some retwork oftware mg not ke installed poperly. Use he Installer b
install he appopriate retwork software

The shared disk you want to connect to does not appear in the Chooser window.

AppleTalk must ke ative before you @n use a shared shi. Make sure hat
AppleTalk is adive in the Chooser omi the AppleTalk Swvitch module of
the Gontrol Strip.

If your nretwork has zores, the shared dk you want ma not ke in the
sdeded zore Make sire he @rred zore is sdected.

The mmputer hat he disk is on mst be tumed on lefore he disk can be
shared. Mke sure hat omputer § on

The mximum numler d users mg be onreded b the disk. Wait a Bw
minutes and ten try aain.

You can’t open a shared disk or folder

You ma not hae the acess priileges reededd use he disk or folder
Ask the retwork admhistrabr or he avner d the shared itenotgrant you
aess

You my have entered gur nane or pasword incorredly when you tried b
open e shared dk or folder Ched with the avner d the item b male
sure you are enteng your nane and pasword corredly, and try aain.

You can’t connect to your own computer from another Macintosh.

Make sure hat your omputer $ tumed on, fle sharhg is tumed on on
your mmputey you hae the orred acess priileges, and you entered
your nane and pasword corredly.

Tips and Troubleshooting
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Application programs

Chapter 12

A program won't open.

Some piograns arit be opened from a bcked floppy disk. Make sure the
disk is unbcked.

The program mg be damged. Reaopy it from a knevn good ®urce (sich
as the original piogram dgk).

There m& not ke enogh menory availabde to open he piogram Quit
other piograns or ciange te piograns menory sze in its Get hfo
window.

Restartt the mmputer hdding the Shift key down, unil you seelte
message “Extengons df.” If this ©lves the pioblem, drag any control
panels or extensons You recerly installed o the Trash

A program doesn’t work, or malfunctions consistently.

You mg have nore han ore wpy of the program on pur had disk.
Renove extra wpies by dragging them b the Trash

Your vergon d the piogram ma not work with your gstem sftware
Chedk with the sftware maufadurer b see \kich verson d the piogram
you shold be wsing.

The pogram mg be allbcated lss menmory than it needs ¢ work with
your daunents Choose Getrifo from the Fle menu and increae he
menory gze

A message says that a program could not be found

You mg be trying to open a deunment created wit a ppgram you dort
have on yur mmputer or created wit a diferent \erson d the piogram
Obtain the @mrred program and vergon. Or open he dacument with
another piogram hat @n read its édrmat. (If enother piogram @n open a
document the program con becmes hghlighted vhen you dra the
document icon D it)

You just did something you didn't mean to do.

You @an wsually undo yur nost recent amon. Most pograns hae an
Undo ommand in the Edit menu §—Z). You annot undo rore han ore
adion.

See he dacumentaton that @ame with your piograns for more informaion
about heir operaton and featura



Refer to this appendix

when you need to install or
reinstall the system software
on your PowerBook.

Appendix A
Installing System Software

System Dftwareis the set 6 prograns and oter files that your @mputer ges
to stat itsdf up, keep trak of your files and run the apgication prograns
you wse When you tum on your mmputey it looks for a dsk that @ntains he
gystem sftware System sftware s alvays in a blder alled he Sstem
Folder.

Any disk that ontains a orred verson d system sftware 5 agtartup dsk.
The statup dik is wually the had disk thats ingde your @mputey thowgh
another had disk or a floppy disk can ako be a statup disk.

If your iomputer annot find a statup dik, it disgays tis icon in the middle
of the screen:

If you seehat icon, you mg need b install or rénstall gystem sftware on
your @mputeis intemal had disk. You @n alko atta® your omputer o an
external had disk that ®ntains he ystem sftware

If your had dsk dready ha sywem ftware a it and you se hat icon: Your
had disk or g/stem sftware m& be damaed, or here ma be poblems with
SCSl devices attabed D your mmputer (See Chapter 8of more informaion
on SCSl devices) You my need b ranstall he ystem sftware See he
sedion on renstalling s/stem sftware hter n this apgndix r instructions
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Before you begin

Installing system

Appendix A

You wse he Installerprogram (which is found on le Install Me Frst disk) to
install reinstall or updateystem sftware on a staup dik. When you wse
the Installer you keep ay spedal files you hae installed h your S/stem
Folder

IMPORTANT Before you install a mw verson d system sftware male a
badkup opy of your curent §stem elderon another disk in case you reed
it later (b use a pogram hat s incompatble with the rew system sftware
for examge).

To install reinstall or updateystem sftware you need

= an initialized had disk (If you hae a had disk that harit been
initialized—hat &, its icon daesrit even apear on he dektop—gp to the
Macintosh Reference book or informaion on hitializing a had disk)

= axess b g/stem sftware (gstem sftware dsks that ame with your
computer or acess  g/stem sftware wer a retwork)

software for the first time

If you have a rew had disk or a remy initialized had disk that daes not
contan g/stem sftware follow the stepsn this setion b do what 5
comnonly called a “nomal” instalation d system sftware

Shut down your computer.
Insert the Disk Tools disk into the floppy disk drive.

Turn on your computer.



Double-click the Disk First Aid icon .

et

Cizk First Aid
Follow the instructions on lhe screenDisk Frst Aid cheds your had drive
for any problems.

When Disk First Aid has finished checking your hard drive, choose Quit from the File
menu.

Shut down your computer.
Insert the Install Me First disk into the floppy disk drive.
Turn on your computer.

The Installerprogram ons autmaically.
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Appendix A

10

11

12

13

Click OK.
The BEasy Install dalog box appears

Easy Install

Click Install to install Version 7.1.1 of
|_o PowerBook 500 Series System Software

software you need.

* Any Existing Printing Software . .
|_- and other software. l Install l Click to install the

on the hard disk named

2 Macintosh HD

Click to install on
Switch Disk a different disk.

Customize Click to install
_m customized software.

Make sure that the hard disk named in the box is the one on which you want to install
system software.

If it isnt, dick the Svitch Disk bution untl the @rred disk name apars
Click Install.

Follow the instructions that appear on the screen.

You see ressages aking you D inset different diks

When you see a message reporting that the installation was successful, click Restart.

If a message repots tat instalation wes not siccessful, try installing again.
(Follow the instructions on lhe scree



Reinstalling system software

If your gystem sftware 5 damaged, you reed o ranstall ystem sftware
These steps oline what 5 omnonly called a tlean” i nstalaton d system
software

1 Shut down your computer.

2 Insertthe Disk Tools disk into the floppy disk drive.
3 Turn on your computer.

4 Double-click the Disk First Aid icon .

ot

Dizk First &id
Follow the instructions on lhe screenDisk First Aid chedks your had drive
for any problems.

5  When you are finished, choose Quit from the File Menu.

6  Double-click the Apple HD SC Setup icon and follow the instructions on the screen.

L1

dpple HD SC Setup
For more informaion on wng Apple HD SC Setup see he Macintosh
Reference book

7 Click Drive until the disk on which you want to reinstall system software appears.

8  Click Update and follow the instructions on the screen.

9  When you see a message that the update (preparation for reinstalling system software)
was successful, click Quit.
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Check to make sure that at least 5 MB of space is available on the hard disk where you
want to reinstall the system software.

Open your had disk and choose B Icon from the View menu The anmount
of space wailabde on he had disk appears n the upperright @rner d the
window. If there B less than 5 MB of disk space ailale, ddete unrecessary
files untl you hare at leat 5 MB d disk space ailale.

Create a new folder named “Old Finder.”

Open the System Folder and drag the file called “Finder” to the Old Finder folder.
Rename the System Folder “Storage.”

Shut down your computer.

Turn on your computer.

The blinking quesion mark con shodd appear

If you dont see the binking question mark: If your omputer stas up you
have another §/stem Blder on wur had disk. Find it (you an use he Fnd
command in the Hle menu) and g bad to step 1

Insert the Install Me First disk into the floppy disk drive.
The Installerprogram ogns autmatcally.
Click OK.

The Basy Install dalog box appears

Easy Install

Click Install to update to Dersion ?.1.1 of
« PowerBook 500 Series System Software

* Any Existing Printing Software

I_- and other software. | Click to install the

software you need.

on the hard disk named

— Macintosh HD

Click to install on
| a different disk.

| Click to install

customized software.
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19
20
21

22

Make sure that the hard disk named in the box is the one on which you want to install
system software.

If it isnit, dick the Svitch Disk bution untl the @rred disk nane apgars
Click Install.

Follow the instructions that appear on the screen.

When you see a message reporting that the installation was successful, click Restart.

If a message repots tat instalation wes not siccessful, try installing again.
(Follow the instructions on he screei

After you are fnished renstalling the g/stem sftware male sure hat your
computer stais up witiout any problems. Once pu knawv that he rew
software ixed any problems you were haing, you @n ranstall aiy spedal
software (ontrol panels, extensons or custom uilities that areit part of your
system sftware) It is best  ranstall he sgdal prograns from te orginal
(or badkup) dsks If you dort have the disks, copy the control panels,
extengons or custom uilities badk to your S/stem elder ore at aime,
restating eat ime Ched after eab restat to see if he oftware @awses a
problem with your computer If you find that awy of your spedal software
items @uwses a poblem, contad the oftwares manufadturer or essistance or
an upgrade

IMPORTANT Be \ery ardul not o repace ay of the files in the §/stem
Folder with files from the Storege folder.

When you have reinstalled or copied any special software, delete the Storage folder.

Installing customized system software

Custom instalaton allbws you 1 sded just the files you want. You @n use
custom instalhtion 1 install or update armgle file or b save space onour
hard disk by installing onl the files you reed.

Shut down your computer.
Insert the Install Me First disk into the floppy disk drive.
Turn on your computer.

The Installerprogram ons autmaitcally.
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10

Click OK.
The BEasy Install dalog box appears

Make sure that the hard disk named in the box is the one on which you want to install
system software.

If it isnit, dick the Svitch Disk bution untl the @rred disk nane apgars
Click the Customize button.

The cistom instalaton dialog box appears All availade comporents & the
system sftware are bted.

Scroll through the list of items and hold down the Shift key as you click the items you
want to install.

If you want to consewe space ongur had dik, sdect the “minimal
softwaré option for your omputer

Click the items you want to select;
Shift-click to select multiple items.

System for PowerBook 500 Series
Min System for PowerBook 500 Series

instal

Software for all Apple printers

= Macintosh HD

Fient Hisk

File Sharing Software
EtherTalk Software

Easy Install

Click Install.
Follow the instructions that appear on the screen.

If you are nstalling from floppy disks, you mg see nassages aking you D
inset different déks

When you see a message reporting that the installation was successful, click Restart.

If a message repots tat instalation wes not siccessful, try installing again.
(Follow the instructions on lhe scree



Refer to this appendix when you
want to use the PowerBook File
Assistant that came with your
computer to synchronize files.

Appendix B
Using the PowerBook File Assistant

The PowerBook Fle Assistantis oftware hat yndhronizes files on yur
PowerBook and dektop Madntosh ly aubmatcally updaing files whenever
you male changes With Hle Assistant, you @n always be sure hat he file
you are vorking on B the curent \ergon.

What is file synchronization?

As a ser ¢ both a dektop Madntosh and a PwerBook, you mg often hae
the same file or folder on bdt computersBut you ma have a poblem
keepng trak of what fles are on Wwat @mputer

The RPowerBook Hle Assistant keeps e nost recent @rson o a file or
folder on bdb your dektop Madntosh and your PowerBook The piocess d
updatng the files on both computerss alledfile sywchronization. With the
PowerBook Hle Assistant, you @n synchronize ndividual files or blders
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Starting the PowerBook File Assistant

Once wu hae installed he FowerBook Fle Assistant, you are reaglto
dedde which files you want to g/nchronize

= Double-click the PowerBook File Assistant icon

&)

FowerBook File Assistant

The Hle Assistant Setup wndow appears:

S[[I=———— File Assistant Setup

=Bl

r

i) 'itgl.'n sé1écted | o] 'itérn selected

Statuz: Mo itemns hawve been selected
Lazt Synchronized: Mever

| ]

Linking files or folders for synchronization

Before you @n gynchronize fles or blders you need o link them Linking
joins wo identcal copies d a file or folder bgether © that when ore file or
folder in the par is nodified, the linked fle or folder s abo changed.

IMPORTANT Files @nnot ke linked if they are notdentcal copies

Before linking, male sire hat eabh computels dock is set 6r the ame ime
and date See he Macintosh Reference book hat ame with your omputer ér
informaion on hav to set he ime and date on gur @mputels dock.
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To link files or blders follow these steps:

Drag an icon of the folder or file you want to link to a selection box in the File Assistant

Setup window.

—
LR Nl a0 ]

Bl b SR rave B IEETR
arh Bgrabrarwed Heor

The item selection box is this area

on either side of the arrow

Drag the icon of the file you want to

synchronize to the item selection box.
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Drag the matching icon to the other selection box.

Once pu hae wo matdting files or blders n the Stup wndaow, you hae a
linked pai. Another par of sdection baes apgears Repeat steps 1rad 2 b

link more pais d files or blders

The setup screengws & you add o the list o linked pars. Use he scoll

bars on e right d the screend see lie pat of the list that s not n view.

Using the PowerBook File Assistant

ecccoe
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Choose two-way |
synchronization
to update either
file when the
corresponding file in
the pair changes.

Appendix B

Setting the direction of the link

Notice he arow between he wo linked fles; tis is hav you @n tdl the
diredion in which the files are Ihked. Normally the PowerBook Fle
Assistant synchronizes files in boh diredions but you @n set he diredion
be ore way, from dther Idt to right or rght D left.

A one-way link is helpful if you want to recéve updated ersons d a
document from a fle server on a etwork.

Click the pair of linked files you want to synchronize one way to highlight it.
Click in the item stection b for ather file or folder in the par.

Choose the direction you want from the Synchronize menu.

Synchronize Now ¥G

+ Manual M
Automatic T

— 4= Two Way ¥=

v ==} Left To Right %] o
| Choose one-way synchronization to update

4== Right To Left I|| afieonyourhard disk from a network server.

The diredion d the arow between he wo linked files in the Setup whndow
changes © rdlect your chaice

The arrow changes to indicate the direction of the link.

Letter to Romero : Letter to Romero

2 Desktop Macintosh 2 PowerBook

Status: The items hawe not been synchronized
Last Sunchronized: MNewer




Linking non-matching folders

PowerBook Hle Assistant lets you ynchronize blders hat hae different
names and mntain different fles.

1  Choose Preferences from the File Menu.

The following dialog box appears:

,@- PowerBook File Assistant Preferences

Click here to be able _] —qﬂllﬂw non-matching folder names

to “nk folders Wlth [ Warn when can't synchronize

different names. [ Warn before deleting

2 Click the checkbox to allow non-matching folder names.

3 Click OK.

Now you @n link folders hat hae different nares and mntents The first
time you ynchronize a pai of non-matding folders PowerBook Fle
Assistant copies all he files from ore folder b the oher folder, 0 that he

folders hge identcal contents
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Deleting a linked pair

If you dorft want to g/nchronize a lhked par anymore you @n ddete he
linked par from the Setup wndow.

Click the pair you want to delete to select it.
To sdéedt more than ore par, hdd down the Shift key and dick other pais
To sdect all pars, choose 8led All from the Edit menu

Choose Delete Pairs from the Edit menu.
Havgdn e
Delete Fairs
Select Al %A

The pars you séected are dieted flom the Setup window.




Synchronizing linked folders or files

The name of the disk —|— = Fowergees

appears here.

To g/nchronize fles or blders yu linked in the Setup wndow, you must do

two things:

= Conred the disks mntaning the files you are gndhronizing.

= Open he PowerBook Fle Assstant.

Now you are reaylto s/nchronize he linked fles or blders Any time you
make a tvange b dther item the same change is maded the linked item If
an item & ddeted, yull b e aked b confirm that you want to ddete he

correspondng file or folder

Information about edtlinked par is dsgayed in the Setup whdow.

S[I=——— File Assistant Setup

EE|

1992 Budget Updates ‘ 1993 Budget Updates

T3 Deskiop Mazintosh

Status: The iterns have been synchronized
Last Synchronized: Mon, May 2, 1992, 2:47 46 FH

If the files have been

Letter

omero ‘ Lethe

&3 Desktop Macintosh 3 PowerBook

Status: The iterns have not been synchronized
Last Synchronized: Mever

synchronized, the time
and date appear here.

You @n set BwerBook Fle Assistant to s/nchronize fles ether manually or
aubmaically. You dhoose vhich you want when you link the itens

Using the PowerBook File Assistant
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Manual synchronization

When you dhoose maual s/nchronization, you decde when you want to
update a hked par.

Select a pair, then choose Manual from the Synchronize menu.

Click the arrow in the File Assistant Setup window.

Click the arrow to synchronize the pair.

I, I,

1993 Budget Updates | | 1993 Budget Updates

A message appears t#i ng you that e files are leing updated.

You @n ako manually update ifes tat are lhked by sdecting the par and
then doosng Synchronize Now from the §nchronize menu

Automatic synchronization

To update Inked fles aubmaically wherever a tiange is maded dther o
the linked fles:

m Select the pair and then choose Automatic from the Synchronize menu.

A message appears vienever files are leing updated. u @n ako set
pairs © be updatedwery ime you onned with another disk. See ‘Setting
Comgetdy Automatc Synchronizatior” later in this Appendix



Understanding the alert messa ges

As you ynchronize linked pars, the PowerBook Fle Assstant dispays alet
messages abouthe ynchronization. You @n tum dof the alet messages by
following these steps:

1  Choose Preferences from the File menu.
A dialog box appears

2 Click the “Warn when can't synchronize” checkbox to deselect it.
The messages do not apear

If you dort want the alet message © appear when a fle or folder s put n
the Trash, dick the chedkbax next to “Warmn before déeting” to desdect it. Be
very ardul if you tum of the alet message that wvams you when files are
put in the Trash Items are putn the Trash during synchronization whenever
a linked item & ddeted or renamd.

3 Click OK.

Alert messages are tuned df. If you want to tum them kadk on, doose
Prderence from the Fle menu and dick the thedkbaxes again to resdect
them

To tum alet messages df temporariy, hdd dowvn the Option key. While you
had davn the Option key, the alet messages for any commands You execute
are tuned df.
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Setting completely automatic synchronization

The PowerBook Fle Assistant needs ® be running in oder b s/nchronize
your files To set up gur gstem b aubmaically synchronize linked fles:

1  Select the pair and then choose Automatic from the Synchronize menu.
2 Use the AutoRemounter control panel to reconnect to shared disks.

See Chapter 7of instructions on audmatcally remnreding (“remouning’)
to shared dks.

3 Drag an alias of the PowerBook File Assistant icon to the Startup Items folder.
The Sartup Itens folder s in your PowerBooKs §stem elder.
See he Macintosh Reference book Pr help on creaitng an alias.

EE g a e ¥ o i i
'F, = w k sl

-
F 31 eyl Flar e

FPowerbook File Assisdant, ¥, EX el P

b O3 Debparions

1 vt ==

pom
=i

FEFTEEE|
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Now whenever AutoRemounter nounts yur wlumes and the RowerBook
File Assistant is running, all aubmaically linked pais are gnchronized.
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Refer to this appendix for

information on using the Macintosh
PC Exchange program that came
with your computer.

Appendix C
Exchanging Files With DOS or Windows

Madntosh PC Eghange is ©ftware nduded wit your momputer hat lets
you edaly exchange dacuments letween yur Madntosh and a DCS or
Windows cmputer You @n use Madntosh PC Eghange © create thppy
disks compatble with DOS computers

Macintosh PC Exchange at a glance

Using the

PC Exchange control
panel, you can specify
which Macintosh
programs are used to
open DOS documents.

For example, DOS
documents whose
names end with
this suffix . . .

... are to be opened
by this program . . .

You can open, edit, and save DOS documents using
your favorite Macintosh application programs.

You can use and create
DOS-format disks.

ettt sy . v
o e il fra
w W e mapsioy [ e

T o
il s B B mar

[ FEEEEE N

B e

B =

... as this type of document.
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Using DOS-format disks on your Macintosh

Appendix C

The format of a dik refers b the way the mmputer prepasethe dik to
recave informaion. Madntosh @mputers ad DCS coomputers ge diferent
disk formats but with Madntosh PC Eghange installed h your Madntosh
gystem your Madntosh @n read diks d either format

To use a D@-format dsk on your Madntosh, smply inset the disk into your
computels floppy disk drive The d&k's icon apars onfte dektop You @n
open e disk by doube-dicking its icon—the same way you would open a
ordinary Madntosh dgk.

Macintosh HD

H When you insert a DOS-format
E floppy disk, you see this icon.

If you see a mssage that he dik is urreadale, see Chapter2ld this book

WARNING Do not attemptd repar a DCS-format dik using disk repar
utility prograns intended ér use on lhe Madntosh Doing 2 is likely to
destroy any informaion on he dik. If you must repai a DC5-format
floppy dik, use a dik repar utility on your DOS computer



Creating a blank DOS-format disk

When you erae or hitialize a d&k on the Madntosh, yu @n dhoose its
format—ather Madntosh or DG

WARNING Before you erae or nitialize a dik, be sire hat he disk
contains no nformaion you want to save

To create allank DOS-formatdisk on your Madntosh, bllow these steps:
Insert a floppy disk.

s If the dik has not keen hitialized, a dalog boc appears n which you @n
spedfy the dik's nane and format.

This disk is unreadable by this Macintosh.
Do you want to initialize the disk?

Format: [ Macintosh 1.4MB -]

[ Eject | [1nitialize

s If the ds&k has alreagl been sed, wull need b erae it. led the dik,
then doose Ease Dsk from the Sedal menu

Spe-::ial
Clean Up Desktop
Enpdy Teash..

Eject Disk 3#E
Erase Disk...

Restart
Shut Down
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A dialog box appears n which you @n spedfy the disk's nane and format

Completely erase disk named
“Homework” (internal drive)?

Format: [ Macintosh 1.4MB |

| cancel || [ Erase |

Type a name for the disk.
Choose the disk format you want from the Format pop-up menu.

The list d availabe formats aries de@nding on your disk drive and the
capadty of the dk. Choose DS if you dan to use he disk on boh
Madntosh aad DOS @mmputers

Completely erase disk named
“Homework” linternal drive)?

Format: | Macintosh 1.4MB |
I Cancel I Erase

Click Erase (or Initialize).

If yodre initializing a d&k, an alett bax appears Click the Goniinue butbn.
The Madntosh preparethe dik in the format you dhose
Usually it takes less than a minute b initialize or erasea floppy disk.

However, if portions d the disk have been damged, te initialization piocess
may take seeral mnutes

If you dhanged he dik’s format the disk’s icon will change when you
re-inset the dik.



Opening DOS documents on your Macintosh

Opening a document from within a Macintosh program

The airest way to open a DCs dacument on he Madntosh B © use he Open
command from within an appication piogram

1  Open the program you want to use.

2  Choose Open from the File menu.

A diredory dialog boc appears

[£3 Aldus SuperPaint 3.0 ¥ |

[0 B&W EPS Files — Hard disk
[0 Color EPS Files
[0 Read Me Folder
[0 Sample Images
0 SP Pouch

fiact

Desktop

[0 Tutorial Files

i

Cancel Many programs have buttons or pop-up

Selected type: menus that let you open or import
Formats... documents of a particular file format.

3 Select the document you want, and click Open.

If you hae pioblems opening the dacunment see Chapter2ld this book
Opening a document by double-clicking its icon

Before you @n open a DCs dacunment by doube-dicking its icon, you need
to use he PC Exhange @ntrol panel to spedfy which Madntosh apfication
programns will open DC5 dacuments as described in the next sedion.
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Assigning Macintosh programs to DOS documents

Using the PC Exhange control panel, you @n assign Madntosh appcaton
prograns b DOS dacunments For exampe, you @n spedfy that all DG5S
documents whose flenanes end wih the sffix . XLS are & be opened in the
Madntosh pogram Microsoft Excd.

The figure telow shavs the PC Exhange @ntrol pandl with some
assgnments alreayl created.

ECI=——— PC Euchange
Each assignment below determines which
Macintosh application prograrn is used when
you open DOS docurnents with a particular suffix.
D05 Suffix  Application Programm Cocurnent Type
DG & Misrosoft Word o woen [
FM4 8 PageMaker 4.0 ALB4
THT 4B SimpleTest TERT
WKE B Lotus 1-2-3 Lwks
DOS documents " € Micrasoft Exeel LS
whose names end
with this suffix... -
%
[ Add... ] [{ HEHT ] [ Ramafs ]
...are to be opened ...as this type
by this Macintosh of document.
program...
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Before you @n assign a Madntosh pogramto a goup d DOS daunments
there arehiree qustions you need b answer:

What suffix do the documents have in common?

Many DOS piograns aubmatcally add aliree-letter wffix (or filename
extenson) to a de@uments nane For examge, these RgeMaker dacuments
all share e aiffix .PM4:

NEWSPM4
REPORI.PM4
RESUME.PM4

What Macintosh application program  do you want to use to open the documents?

Each Madntosh daument ha acreator—that 5, the Madntosh pogram
used b createlte document. When you doulte-dick a daunments icon,
the Madntosh oens he piogram hat createdhe deccument.

Using the PC Exhange @ntrol panel, you @n assign Madntosh pograns
to DOS dauments & “creabrs’

What type of document is it?

Most prograns are ale to open or impot some, but not all types d
documents A documentstypeis a hree- or burletter ode (sich as
TEXT or PICT) that tdls a pogram whether or not it @an re@gnize he
document. A pogram dsfdays dauments @ types it can remgnize n its
diredory dialog box.

Unless you spedfy otherwise the Madntosh asumes that all DG5S
documents hge the daument type TEXT. You @n assign different tyes
to osme DCS dacuments See he rext sedion.

A documents type is different fom itsfile trmat, which refers b the way
informaion within the dacument s enoded. If a pogram s unalbe to
accuratdy interpret a deunments file format the dacuments formating may
be disdayed incorrealy. (To find out vhich file formats a ppgram @n
understad, rder b the daumentaton for the piogram)

Exchanging Files with DOS or Windows
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Recommended assignments for some widely used application
programs

The informaion in this setion will help you asign daccuments fom me
widdy used DCGB/Windows piograns b ome widdy used Madntosh
programns. (For more informaion, seelie dacumentaton for your apgication
prograns)

AMI Pro (Windows), version 2.0

Docunents h AMI Pro (Windows) verson 20 are autmatcally saved with
the auffix .SAM.

To open hese dauments onhe Madntosh, add oe d the foll owing
assgnments b the PC Exhange @ntrol panel:

DOS Suffix Macintosh application Document type
SAM @ MacWrite® Il (version 1.1) TEXT
SAM @, Microsoft Word (version 5.0) TEXT
SAM g WordPerfect (version 2.0) ﬁ' TEXT

.SAM @ WriteNow (version 2.2) TEXT

Lotus 1-2-3 (Windows), version 1.0

Documents n Lotus 2-3 (Windaows) verson 10 are autmatcally saved with
the auffix .WK3.

To open hese Lotus 12-3 decuments ontie Madntosh, add oe d the
following assgnments b the PC Exhange ontrol panel:

DOS Suffix Macintosh application Document type
WK3 E Lotus 1-2-3 (version 1.0) D TEXT
WK3 =% Microsoft Excel (version 3.0) TEXT



Microsoft Excel (Windows), version 3.0
Documents n Microsoft Excd (Windows) verson 30 are autmatcally saved
with the suffix . XLS

To open hese Microsoft Excd documents onthe Madntosh, add oe d the
following assgnments o the PC Exhange @ntrol panel:

DOS Suffix Macintosh application Document type
XLS E Lotus 1-2-3 (version 1.0) D TEXT
XLS =% Microsoft Excel (version 3.0) TEXT

Microsoft Word (Windows), version 2.0

Docunents h Microsoft Word (Windows) vergon 20 are autmatcally saved
with the suffix .DOC.

To open hese da@uments n Microsft Word (Madntosh) vergon 50, add he
following assignment b the PC Exhange control panel:

DOS Suffix Macintosh application Document type

.DOC @ Microsoft Word (version 5.0) _@ WDBN

PageMaker (Windows), version 4.0

Docunents h PegeMaker (Windows) verson 40 are audmaitcally saved with
the suffix .PM4.

To open hese da@uments h PageMaker (Madntosh) \ergon 40, add he
following assignment b the PC Exhange control panel:

DOS Suffix Macintosh application Document type

PM4 @ PageMaker (version 4.0) ALB4
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Quattro (DOS), version 3.0

When sving documents n Quattro (DOS) verson 30, be sure b save them
with the suffix WK1 (rather than the ddaut suffix, .WQ1) Quattro saves
documents endig in \WK1 in the Lotus 12-3 file format which can be
intempreted ly many Madntosh spreadstet pograns

To open hese Quttro documents onhe Madntosh, add oe d the following
assgnments b the PC Exhange @ntrol panel:

DOS Suffix Macintosh application Document type
WK1 #9 Claris Resolve™ (version 3.0) TEXT
WK1 E Lotus 1-2-3 (version 1.0) D TEXT
WK1 2% Microsoft Excel (version 3.0) TEXT

Ventura Publisher (Windows), version 3.2

Docunments h Ventura Riblisher (Windows) verson 32 are autmatcally
saved with the suffix .CHP

To open hese da@uments h Ventura Riblisher (Madntosh) verson 32, add
the following assignment b the PC Exhange ontrol panel:

DOS Suffix Macintosh application Document type

.CHP f Ventura Publisher (version 3.2) . VCHP

WordPerfect (DOS), version 5.1

WordPerfed (DOS) werson 51, does not aubmatcally add a dffix to the
names d documents The eaiest way to open WrdPerfed (DOS) dacuments
on the Madntosh b by choosng the Open @mmand from within an
apgication program



Adding an assignment to the PC Exchange control panel
To add & assignment follow these steps:

Choose Control Panels from the Apple (&) menu.

The Gontrol Panels windowv opens

Open the PC Exchange control panel.

Douhe-dick the PC Exhange icon, or sé&d the icon and choose @en from
the Fle menu

il

FC Exchange

The PC Exhange ontrol panel appears

E[I=—— PC Exchange
Each aszignment below determines which
Mazintosh application program is used when
you open DOS docurnents with a particular suffix.

LOS Suffix Application Program Crocurnent Type
ki
L

[ Add... ] [ fhannge.. ] [ Hamans ]
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3 Click the Add button.

Add...

A dialog boc appears h which you @n spedfy a DOS auffix and its
corresponding Madntosh appcaton piogram and daunment type

Assign an application to a D0S suffix:

— D05 Suffiz Docurnent Ty pe —‘

|<‘j] Applications folder ¥ | — Hard disk

O Claris Software
[0 CompuServe

application Prograrm

_I @ (Mot specified)

fieot

[ Design '89
O Disinfectant folder g
3 Fourth Dimension

[0 Mac In Tax
& Macllrite

& Microsoft Excel [ 0K ]

4 Type athree-letter DOS suffix in the DOS Suffix ~ box.

Assign an application to a DOS suffix:

Crocurnent Type —‘

To spedfy which Madntosh pogram will opgen DG5S dacuments wih no
auffix, cdick indde the b to set he insetion pant, but leae it Hank.

Applization Program

DOS Suffix
’7 @ (Mot specified)
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6

Select a Macintosh application program from the lower section of the dialog box.

Assign an application to a DOS suffix:

— D03 Suffix

Application Program

Mackwrite TEHT

Docurnent Type
-

+= Applications folder ¥ | — Hard disk
[ Claris Software
[0 CompuServe
[ Design '89
[0 Disinfectant folder [l
3 Fourth Dimension
[0 Mac In Tax
& Macllrite
<& Microsoft Excel [ 0K ]

Choose a document type from the Document Type pop-up menu.

Assign an application to a DOS suff:

Application Program

D05 Suffix
( Macwrite

Document types are ndicated ly icons and fourletter ®des whose neanings

are sedom obvous. For help choosng the @rred docunment type see he

informaion in the previous setion, “Recommended Asignments br Some

Widdy Used Application Pograns”

If you dort know which document type © choosetry TEXT.

Once you've specified a DOS suffix
appropriate document type, click OK.

, & Macintosh application program, and the

The asignment s addedd the list in the cntrol panel.
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Trying out an assignment

To try out an assgnment youve addedd the PC Exhange mntrol pane,
follow these steps:

1  Inserta DOS-format floppy disk and open its icon.

PC Exhange assignments tak dfed when you inset a floppy disk, or when
you open a DGB-format floppy disk. (If the disk window was alreagt open,
you reed o dose it ad open it &ain)

2 Double-click the icon of a DOS document whose filename ends with the suffix you
specified.

The dacument s opened by the appopriate Madntosh apfication program
(You might see a mssage that he dacunents file format s being cornverted)

If you hae poblems opening dacuments see Chapter2ld this book

Editing the list of assignments

You @n change renove and ort assignments n the PC Exhange @ntrol
panel.

E[ ===———— PC Exchange

Each aszignrnent below determines which
Macintosh application prograrn is uzed when
you apen D05 docurnents with a particular suffis.

TO Sort the ||St Of — DOS Suffix  Application Prograrm

Drocurnent Type

assignments, click Dot & Microsoft word o owoen [T
a category. PM4 B PageMaker 4.0 ALE4

=T EB simpleText TERT

HLS % Microsoft Excel

|

[ Add.. | [change... ] [ Remove J—{ TO remove an assignment, select it
in the list, then click Remove.

To change an assignment, select
itin the list, then click Change.
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Sharing assignment lists with other users

The list d assgnments s sbred n the PC Exhange Préerencs file. This
file is sbred in the Préerencs folder indgde he Sstem felder

]

FC Exchange Preferences

You @n male sure hat every licensed ser d Madntosh PC Eghange in
your dfice ses the same asgnments Make apies d the PC Exhange
Preerencs file and dace or wpy in the Préerencs folder (insde he
System Blder) d ead licensed sets Madntosh

Do not dcange the nane d the PC Exhange Préerencs file.

Saving documents onto a DOS-format disk

You sve dauments ond a DGB-format dik the same way you sve them
ont a Madntosh di&k—1Uy choosng the Swve ommand from the Fle menu

IMPORTANT Be sure D leave at leat 5K d extra disk space Wen you sve or
copy files onb a DCs-format floppy disk. (The Madntosh reeds his spaced
store Madntosh-sgdfic informaion aboutiles on he dik, auch & the
location d icons and windows on he Madntosh dektop)
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The Save As dialog
box may include
buttons or pop-up
menus for choosing

a file format. __| L {File Format...] Normal

Appendix C

Choosing a file format

In ©ome piograns youll have the doice d saving the dccument in ore d
several fle formats

= To-prod ¥

T Bri et 3]
0 fuwens Yo Produ Hos
o Screens (100%)
[ Screens (with callouts)
]
Save Current Document as: — Hard disk
|Memu.doc | 2119K available

[ ¥ast saus [] Make Backup l Save l Bl

A documents file brmat refers b the way informaton within the dacument s
enmded. If a popgram @nnot acuratdy intempret a deunments file format it
may disgay the dacument incorredly (as in the figure kelow).

ES[[=———=— Untitled Egﬂ
00000004 docurnent’s file format refers to the
way information within the document is encoded. If
a program cannot accurately interpret a document’s
file farmat, it may be unable to apen the document,
or it may not be able to accurately interpret the
formatting codes in the document (as in the figure
below). 00000

=]

When you sve a deumentthat you dan to use wit another program be
sure b sve it in a fle format hat he oher piogram @n understad. (7o find
out what fle formats a pogram b5 alte to open, impot, and swve, see lhe
documentaton you recéved wit the program)

Naming files for use on both Macintosh and DOS computers

On DCs ommputersfilenanes are limiteda eght dharaders (pus a hree-
letter &iffix) and ma not @ntan space The rules for namng Madntosh
files are les restrictive Therdore when working on he Madntosh, its
possible to give a fle a nane that would be “illegal” on DOS cmmputers



For examge, suppose gu created ailé on your Madntosh naned
July Budget.DOC

If you viewed he sanme file on a DG5S computer its nane would be
IJULYBUD.DOC

The exdlamaton mark (!) ndicates that he nane ha been shaened.

A file can thus hae two nanes: a bng nane (for when te file is dsdayed
on the Madntosh) and a shatrname (for when its dspgayed on a D@
computer)

While using a DG5-format floppy disk on he Madntosh, yu @n see a
documents shot nane by sdeding the daument choosng the Get hfo
command from the Hle menu, ad dicking the dauments nane in the Info
dialog bax. (For this piocedure b work, you must hae the Fle Sharing
Extenson installed.

Long name Short name

E= Jull_.LIBudget.LUKS Info [EO= July[Budget.WKS Info

L |
du]gﬁudget.DDC !.JUL\‘RUD.DDC

Kind : Mac'rite documnent Kind : Mac'w'rite document
Size : 10K on disk (2,783 bytes used) Size: 10K on disk (9,783 bytes used)

Viewing the contents of a disk on your DOS computer

When you view the diredory o a disk on your DCS mmputey you might
notice additonal dredories naned RE®URCEFRK. These dredories
contain important informaion, knavn as resources which are ontained in
some Madntosh da@uments

WARNING Do not déete or nove any diredories haned
RESOURCE FRK, and do not mve any files out d these dredories
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Index

A

About This Macintosh (Apple
menu)| 110
AC power 63
Active windows, 31, 37
ADB devices
connecting 108
power consumption of 108
ADB port | 105, 108
Airline travel, security and
restrictions| 85
Alert messages (PowerBook File
Assistant) 145
AMI Pro 2.0 (Windows)| 154
Apple Desktop BusSeeADB
Apple HDSC Setup icon 133
AppleTalk 127 See alsmetworks
Phase 1 and Phase 2 protocols for
Ethernet 112
printing on | 84

turning connection on and off €1--62
AppleTalk Switch module (Control Strip)

61-62, 127
Application menu 42

Application programs
assigning to DOS documents
152--160
opening documents from within 38
opening DOS documents from within
151--152
troubleshooting 128
Arms, discomfort in| 51
Arrow keys | 43
Assigning Macintosh programs to DOS
documents 152-154
Audio input and output 108
Automatic file synchronization 146
Automatic power conservation,
controlling | 74
Automatic sleep 7, 64, 70
messages prior to 64
recharging batteries after |68
troubleshooting 119
AutoRemounter control panel |77

Backing up System Folder 130
Backlight dimming.Seescreen dimming
Balloon Help| 53

S 165


Instructions

To go to a page, 
click its page number.


Batteries| 46, 56, 53, 63—/dee also
Control Strip; power
burns from 67
caring for 47
charge level of 56-58, 64
charge, life of 57, 63, 69—70, 12--73
charging| 1, 57, 63
conservation settings €9, 71, 73-74
conserving power of 59, 68—70,
72-73
consumption rate of 57
damage to 65, 67
discarding 67
discharging| 68
door on| 66
environmental hazards from |67
estimated work time remaining 57
handling| 45| 47
hard disk consumption of 59
low-power messages 64
recharging 45—46, €3, €566, 68
recycling| 47, 67
removing or replacing 66—58
SCSI disk mode and 95
transporting 85
troubleshooting 119
Battery Conservation section
(PowerBook control panel)
68--70| 72-73
adjusting settings 69—71
Custom options 72
customizing| 73
Battery icons 57
Battery Monitor module (Control Strip)
56--58| 65-66, 68
customizing 58
Battery terminal, short-circuiting 46
Blinking question mark icon 5, 120,
129,134
Brightness contro| |5
Burns from batteries 67

C

Cables
Ethernet| 115-114
HDI-30 SCSI System Cable 87,
91-92
safety and 45, 91
SCSI Disk Adapter cable 93-95
SCSI peripheral interface cable 91-92
video | 99
Cancel buttor; 31
Caps Lock key 43
Care and safety instructions | 45
Chair, position of 50
Character key 42
Charging batteries |1, 45-47, 57,63, 65
troubleshooting 119
Chooser 126-127
Cleaning the PowerBook 47
Close box 21, 31
Close command (File menu) 38
Closing
Control Strip| 12, 54
documents 25, 38
windows | 31, 36
Clues on your screen 0--31
Command key 43
Connecting
ADB devices 108
to Ethernet 112-114
external modem 106-107
external monitor 98
mouse, 108
power adapter -2
PowerBook between two devices on
Ethernet| 112
printer | 107
SCSI devices 87-96
SCSI disk adapter cable 94--95
sound input devices 108-109
sound output devices 109
Connectors, 46
Conserving battery power %9, 68-69, 71,
73-74



Contrast contro| |5 Copying

Contrast, screen |5, /51 floppy disk contents 40

Control key, 43 icons| 35

Control panels (Apple menu) CPU, processor cycling and |73
AutoRemounter 77 Creating

Battery Conservation options 69-74 documents 22-27
for external modem setup 106-107 files |22--24, 262

for RAM disk setup 7&6-81 folders | 26, 41
for set as SCSI disk 93-94 Cumulative trauma disorders (CTCs)| 48
Memory control panel 73—-81 Custom options for battery conservation
Monitors control panel 99-101 70, 72--73
opening| 69 Customizing
PowerBook Display control panel 103 Battery Conservation section
PowerBook Setup control panel (PowerBook control panel)
93--94/| 106-107, 125 72--74
processor cycling options 73 Battery Monitor module (Control
Startup Disk control panel 81 Strip) 58
Trackpad control panel 76 PowerBook 7:5—7(, 83—84
vs. Control Strip 54 system software 135-136
Control Strip| 53-56, 58—63ee also
batteries; power D

appearance of 53
AppleTalk Switch module 61-62, 127pgjete key 43

battery conservation settings| 58 Deleting items from hard disks
Battery Monitor module 56-58, 28129l 35

. 65--66. 63 Desktop
closing 12, 54 appearance of 20
customizing| 58 organizing 41
File Sharing module 60 removing Control Strip from 55
HD Spin Down module 59 Dialog boxes, keyboard shortcuts in 42
hiding and showing 55 Dimmed commands 42
IOcaFion of 12 D|mm|ng screen
moving |56 on external monitor 102
opening| 54 on PowerBook 69, 71
power | 53 Directory dialog boxes, keyboard
Power Settings module 58, 69, 72-74 shortcuts inl 42
purpose of 53 Discarding batteries 57
rearranging modules in 56 Disk drives
resizing| 55 external, using PowerBook as| 94
Sleep module 70-71 troubleshooting 12
Sleep Now module 59 Disk First Aid icon| 131, 13
Sound Volume module 61 Disk formats' 148
Video Mirroring module 62, 103 Disk Tools disk 13(—131, 133
vs. control panels 54 Disk Tools icon| 130, 13
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Index

Disks.See alsdloppy disks; hard disk;

RAM disk; shared disks
menus of| 39
opening higher levels of 37
troubleshooting 122-123
working with | 40--41

Display.See alsanonitor, external;

screen
angle of| 3
opening| 3

Documents 3&—-3%ee alsdiles

closing | 25, 38
creating| 22-27
deleting with Trash 28-29, 36
DOS | 147
naming 23-24, 39
for use on Macintosh and DOS
computers 162
opening| 38
saving| 23-24, 39, 125
in folders| 39
onto a DOS-format disk 151
storing in folders 26-27
types of| 153
working with | 38--39

DOS documents

assigning Macintosh programs to
152--158, 160-161
opening on a Macintosh 151

DOS, exchanging files with 147
DOS-format disks 148-150

erasing 149-150

formatting| 150

icon for| 148

initializing 1 149--150

repairing| 148

saving documents onto 161-162

viewing contents of on DOS
computer 163

DOS suffixes 152—-155, 158-159
Double-clicking| 13, 38

changing speed of 76

Dragging
Control Strip| 56
Control Strip modules 56
icons| 35
items from screen to external
monitor | 97
items to folders 27
items to Trash 28
window size box 36

E

Editing text, with Delete key 23
Ejecting floppy disks 40
troubleshooting 124
Electrical hazards 45
Electromagnetic emissions |52
Emptying Trash 29, 36
Erase Disk command (Special menu) 41
Erasing floppy disks 41, 149-150
Erasing items from hard disk 28-29 36
Error messages 94, 128ee also
troubleshooting
after connecting SCSI chain |94
system error |7
when printing| 126
Errors, correcting with Delete key |23
Escape key 43
Ethernet| 111-114
Ethernet adapter 111-114
Ethernet cable 113-114
Ethernet network 111-118ee also
networks
connecting directly to printer
with |114
connecting PowerBook between two
devices on 112-113
connecting PowerBook to end of 113
protocols for| 112
Ethernet port 105, 107, 111-112, 114
EtherTalk| 111-112
Exchanging files with DOS or
Windows| 147



External modemSeemodem, external
External monitorSeemonitor, external
Eye fatigue 49

FG

Fatigue, avoiding 52
File sharing 60

File Sharing module (Control Strip) 60

File Sharing Setup control panel 60
File synchronization
alert messages for 145

automatic synchronization 144, 146

deleting a linked pair 142
linking files or folders for 136-139
linking non-matching folders 141
manual synchronization 144
purpose of 13
setting the direction of the link 140
synchronizing linked folders or
files 1143
Files
closing | 25, 38
creating| 22-27
deleting with Trash 28-29
DOS | 147
opening on a Macintosh 151
exchanging with DOS or
Windows| 147

linking for synchronization 133-139

locked | 124

naming 23-24, 39, 162

opening| 38

saving| 23-24, 39, 125

onto a DOS-format disk 1561

sharing| 60

storing in folders 26-27

synchronizing between PowerBook
and desktop Macintosh
137--146

Finder
keyboard shortcuts in 42
returning to, 30

Floppy disk drive, troubleshooting 123
Floppy disks 40-41

as startup disk 129
copying contents of 40
copying contents to another disk| 40
DOS-format 147, 149-158ee also
Macintosh PC Exchange

ejecting| 40

troubleshooting 124
erasing 41, 149-150
initializing | 149--150
locking/unlocking| 125
restarting from 117
troubleshooting 122
working with | 40--41

Folders

creating| 41

dragging items to 27

icons for| 34

linking for synchronization 133-139

menus of| 39

naming| 26

opening| 27, 39

opening higher levels of 37

placing icons inside 41

saving documents in 26—27,/39

storing work in| 26-27

synchronizing between PowerBook
and desktop Macintosh
137--146

Fonts, troubleshooting 126

Format, disk 148

Formatting DOS-format disks 149-150
Function keys 43

Hands, discomfort in 51
Hard disk

as startup disk 129

built-in terminator for| 90

copying contents of to floppy disk 40
copying floppy disk contents to 40

Index
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Index

deleting items from 23-29, 36
externall 129
installing system software on
129--136
power consumption of 71
spinning down 59, 71
storing documents on 23-24
troubleshooting 122, 129
turning off when not in use 59
using PowerBook as 23-95
Hard disk icon| 20, 3
Hard disk sleep, controlling 71
Hard disk windowsSeewindows
HD Spin Down module (Control
Strip) 59
HDI-30 SCSI Disk Adapter 93
HDI-30 SCSI System Cable 87, 91-92
Headphones 105, 109
Health-related information 43-52
Help menu 42, 53
Hiding and showing Control Strip 55
Highlighted commands 42
Highlighting text| 24

l,J

I-beam pointer &3

Icons | 34:-36
Apple HD SC Setup 133
blinking in menu bar 120
blinking question mark 5, 129, 134
copying| 35
deselecting 34
Disk First Aid | 131, 133
Disk Tools| 130, 133
DOS-format disks 148
dragging to Trash 28
folder icons| 34
hard disk icon 20, 34
lightning bolt| 65
moving | 35
naming and renaming 35
opening| 35

placing inside folders 41

PowerBook File Assistant 138

putting away, 36

RAM disk |79

recovering from Trash 29

removing with Trash 28, 36

SCSI 94

SCSI port 87

selecting groups of 34

selecting lists of 34

Trash 28-29

video port icon 99, 104

working with |34
ID numbersSeeSCSI ID number
Initializing DOS-format disks 149-150
Install Me Firstdisk ' 130-131, 134—135
Installer 130-131, 134-135
Installing

PowerBook File Assistant 138

software drivers €8

system software 125-136
Internal hard diskSeehard disk
Internal modemSeemodem, internal
International power requirements ' 85

K

Keyboard

angle of| 51

position of| 50

special keys on 43
Keyboard shortcuts 42
Keys, special 43

L

Laser printer
networks anc &4
Lightning bolt icon 65
Locked disks 125
Locked files| 124
Lotus 1-2-3 version 1.0 (Windows) 154
Low-power messages 64



M

Macintosh
opening DOS documents on 151
synchronizing files between
PowerBook and desktop
Macintosh| 137
synchronizing files with 137-145
Macintosh Basics tour 9-10, 1.2--15
Macintosh PC Exchange 147-148,
152--163
assigning Mac programs to DOS
151--158, 160-161
control panel
adding assignments to 152,
157--158
editing assigment lists 160
trying out assignments in 160
opening DOS documents with 151
Preferences file 161
purpose of 147
saving documents onto DOS disks
with 1161--162

Macintosh programs, assigning to DOS

documents 152-153

MacTCP| 112
Maintenance 45
Memory

insufficient amount of 121

persistent RAM 75

protecting contents of 64

upgrading| 110

virtual memory 69, 110
Memory control panel 73—-31
Menu bar| 30

blinking icon in| 120

displaying on external monitor 101
Menus, working with 42
MessagesSeealert messages; error

messages; low-power messages

Microphone 109
Microprocessor, processor cycling
and 73

Microsoft Excel 3.0 (Windows) 155
Microsoft Word 2.0 (Windows) 155
Modem, external
connecting 106—107
troubleshooting 125
Modem, internal 106-107
power consumption of 69
troubleshooting 125
Modem/Printer port 105
Modules| 53
Monitor, external 97-104%&ee also
screen
activating 100

as extension of PowerBook screen 97

connecting 98

disconnecting 104

displaying menu bar on 101

position of| 93

power adapter and 98

presentations and 103

troubleshooting 122

trouble with| 100

working with | 102:-103
Monitors control panel 100-101
Mouse

adjusting tracking speed of 83

adjusting track length of 33

connecting 108

position of | 51
Moving

Control Strip| 56

icons| 35

pointer with Trackpad 10
Musculoskeletal discomfort 48-49

N

Naming
documents 23-24, 39

files for use on both Macintosh and

DOS computers 162
folders| 26
icons| 35

Index
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Networking services 111 Pointer

Networks| 111-114 I-beam| 83
AppleTalk |61:-62, 84, 112 improving display of 7%, 83
automatically connecting to shared moving 10
disks | 75| 77 troubleshooting 120
Ethernet, connectingto 111-114 Ports| 105
installing system software on ADB port |105; 108
130,/ 132 Ethernet port 105, 107, 112, 114
passwords and 77 EtherTalk port 111
Print Later option 7%, 84 modem/printer port 105-107
troubleshooting 127 power adapter port 105
zones 126-127 SCSI port 87, 91, 105, 107
New Folder command (File menu) serial port 105-107
26,41 sound input port 105, 109
Nickel-metal-hydride (NiMG) batteries. sound output port 105, 109
Seebatteries video port| 97, 99, 104-105
PostScript laser printer, networks and 84
0 Power| 64-70, 72—7&ee alsdatteries;
Control Strip; power adapter
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PowerBook

Getting Started

Setup and important health-related information
for the PowerBook 520, 520¢, 540, and 540c computers


Instructions

To go to page 1, click anywhere on this title page.


& Apple Computer, Inc.
© 1994 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be copied, in whole or in part, without the
written consent of Apple. Your rights to the software are governed by the accompanying
software license agreement.

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S. and other
countries. Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without
the prior written consent of Apple may constitute trademark infringement and unfair
competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Apple is
not responsible for printing or clerical errors.

You may use the software on any computer owned by you, but extra copies cannot be made for
this purpose.

© 1994 Apple Computer, Inc.
20525 Mariani Avenue
Cupertino, CA 95014-6299
(408) 996-1010

Apple, the Apple logo, AppleShare, AppleTalk, EtherTalk, LaserWriter, Macintosh, MacTCP,
PowerBook, and StyleWriter are trademarks of Apple Computer, Inc., registered in the U.S. and
other countries.

AppleColor, Apple Desktop Bus, AudioVision, Disk First Aid, Finder, Macintosh PC
Exchange, and QuickTime are trademarks of Apple Computer, Inc.

Aldus and PageMaker are registered trademarks of Aldus Corporation.
Canvas is a trademark of Deneba Software.

CompusServe is a registered service mark of CompuServe, Inc.

Lotus is a registered trademark of Lotus Development Corporation.

Macintosh Basics was developed using VideoWorks Interactive. MacroMind is a registered
trademark, and VideoWorks is a trademark, of Macromedia, Inc. (formerly MacroMind, Inc.).

MacDraw and MacWrite are registered trademarks of Claris Corporation. Claris Resolve is a
trademark of Claris Corporation.

Microsoft is a registered trademark, and Windows is a trademark, of Microsoft Corporation.
Quattro is a trademark of Borland International, Inc.

Ventura Publisher is a registered trademark of Ventura Software, Inc.

WordPerfect is a registered trademark of WordPerfect Corporation.

WriteNow is a registered trademark of T/Maker Company.

Simultaneously published in the United States and Canada.

Mention of third-party products is for informational purposes only and constitutes neither an
endorsement nor a recommendation. Apple assumes no responsibility with regard to the
performance or use of these products.
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Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

= Turn the television or radio antenna until the interference stops.
= Move the computer to one side or the other of the television or radio.
= Move the computer farther away from the television or radio.

= Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpfatference
Handbook(stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.
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DOC statement

DOC Class B Complianc&his digital apparatus does not exceed the Class B limits for radio

noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—ClasseCBt appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme

sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.

VCCI statement
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